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Introduction

It’s not hard to get developers interested in ASPNET. Without exaggeration, ASPNET is the most
complete platform for web development that has ever been put together. It far outclasses its prede-
cessor, ASP, which was designed as a quick-and-dirty set of tools for inserting dynamic content into
ordinary web pages. By contrast, ASPNET is a full-blown platform for developing comprehensive,
blisteringly fast web applications.

In this book, you'll learn everything you need to master ASPNET 2.0. If you've programmed
with a previous version of ASPNET, you'll sail through the basics and quickly begin learning about
the exciting new features in version 2.0. If you've never programmed with ASPNET, you'll find that
this book provides a well-paced tour that leads through all the fundamentals, along with a back-
stage pass that lets you see how the ASPNET internals really work. The only requirement for this
book is that you have a solid understanding of the Visual Basic language and the basics of .NET. If
you're a seasoned Java or C++ developer but you're new to .NET, you may find it easier to start with
a book about .NET fundamentals before you read this one.

ASP.NET from 1.0 to 2.0

As you no doubt already know, ASPNET is Microsoft’s next-generation technology for creating
server-side web applications. It’s built on the Microsoft .NET Framework, which is a cluster of
closely related new technologies that revolutionize everything from database access to distributed
applications. ASPNET is one of the most important components of the .NET Framework—it’s the
part that enables you to develop high-performance web applications and web services.

ASPNET 1.0 was a revolution in the web programming world. It was so wildly popular that it
was licensed on thousands of commercial web servers through Microsoft’s Go-Live license program
while it was still a beta product. ASPNET 1.0 was finally released in early 2002.

ASPNET 1.1 wasn't as ambitious. Instead, it was just a chance for Microsoft architects to pause
and catch their collective breath. The focus in ASPNET 1.1 wasn’t on new features—there weren't
any—but on performance tune-ups, security tweaks, and minor bug fixes. New features were quietly
shelved and saved for the next major milestone, ASPNET 2.0. ASPNET 1.1 was released late in 2003,
solidifying ASPNET as the web development platform of choice for professional developers.

Two long years later, ASPNET 2.0 finally appeared. Unlike the ASPNET 1.0 release, ASPNET 2.0
doesn’t represent the start of a new direction in web development. In fact, almost all the underlying
architecture that underpins ASPNET 1.0 remains the same in ASPNET 2.0. The difference is that
ASPNET 2.0 adds layers of higher-level features to the existing technology. Essentially, after the suc-
cess of ASPNET 1.0, Microsoft poured developers, time, and resources into planning and preparing
ASPNET 2.0. Because they no longer needed to rewrite the ASPNET engine, the ASPNET team
members were free to be innovative with new controls, create better data management solutions,
build a role-based security framework, and even make a whole toolkit for creating portal websites.
In short, ASPNET 2.0 gives developers a chance to relax and enjoy a wealth of new frills designed
for their favorite platform. In this book, you’ll learn how to use, customize, and extend all these
features.
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Note For an example of ASPNET’s remarkable scalability, consider that MySpace.com recently switched to
the ASP.NET platform. (Pages were originally created with ColdFusion, and even though they now run on ASP.NET,
many still have the original .cfm extension so as not to break old bookmarks.) At the time of this writing,
MySpace.com is the fastest-growing site on the Internet. Each day it registers 260,000 new users, handles
2.3 million concurrent users, and processes 1.5 billion page views.

What Does This Book Cover?

Here is a quick breakdown of what you'll find in this book:

Part 1, “Core Concepts™ You'll begin in Chapter 1 with a look at the overall ASPNET platform,
the .NET Framework, and the changes in store for ASPNET 2.0. In Chapter 2 you'll branch out
to learn the tools of the trade—namely, Visual Studio 2005. In Chapters 3, 4, 5, and 6 you'll learn
the key parts of the ASPNET infrastructure, such as the web-page model, application configu-
ration, state management, and caching. As you learn these core concepts, you'll take a low-
level look at how ASPNET processes requests and manages the lifetime of your web applica-
tions. You'll even learn how to extend the ASPNET architecture.

Part 2, “Data Access”: This part tackles one of the core problem domains for all software
development—accessing and manipulating data. In Chapters 7 and 8 you'll consider the fun-
damentals of ADO.NET as they apply to web applications and learn how to design data access
components. In Chapter 9 and Chapter 10 you'll learn about ASPNET’s set of innovative data-
bound controls that let you format and present data without writing pages of code. Chapter 11
branches out into advanced caching strategies that ensure blistering performance. Finally,
Chapters 12 and 13 move beyond the world of databases to show you how to work with XML
content and handle ordinary file access.

Part 3, “Building ASPNET Websites”: In this part you'll learn about essential techniques and fea-
tures for managing groups of web pages. You'll start simply with user controls in Chapter 14,
which allow you to reuse segments of the user interface. In Chapter 15 you’ll consider two

new ASPNET innovations—themes (for styling controls automatically) and master pages (for
reusing a layout template across multiple pages). Chapter 16 shows how you can use the new
navigation model in ASPNET 2.0 to let visitors surf from one page to another. Finally, Chapter
17 explores localization, and Chapter 18 describes deployment and the IIS web server software.

Part 4, “Security”: In this part you'll look at ASPNET’s rich complement of security features.
You'll start with a high-level overview of security concepts in Chapter 19 and then learn the ins
and outs of forms authentication (Chapter 20) and the new membership API that works with
it (Chapter 21). In Chapter 22 you'll tackle Windows authentication, and in Chapter 23 you'll
learn how to restrict authenticated users with sophisticated authorization rules and use role-
based security. In Chapter 24 you'll explore the profiles API, which is a new, prebuilt solution
for storing user-specific information, and in Chapter 25 you'll go one step further and learn
how to protect the data you store in a database as well as the information you send in a URL
with encryption. Finally, Chapter 26 shows how you can plug into the ASPNET security model
by designing a custom membership provider.

Part 5, “Advanced User Interface”: This part shows how you can extend web pages with
advanced techniques. In Chapters 27 and 28 you'll tackle custom controls. In Chapter 29
you'll branch out to use GDI+ for handcrafted graphics. Finally, Chapter 30 explores the
ASPNET 2.0 Web Parts Framework for creating flexible web portals.
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Part 6, “Web Services”: Web services promise to revolutionize the way functionality is shared
across different applications, network environments, and computing platforms. In Chapter 31
you'll start at the beginning; you'll see how to create basic web services and how to use them in
ASPNET web applications, .NET Windows applications, and even legacy ASP applications. In
Chapter 32 you'll take a low-level look at the standards that make it all possible and see how
they work. In Chapter 33 you'll learn how to use advanced techniques to call web services asyn-
chronously, implement secure services, and start working with newer web service standards
using the WSE (Web Services Enhancements) toolkit.

Part 7, “Client-Side Programming”: Recently, Ajax and other client-side scripting techniques
have allowed programmers to create next-generation web applications that are slicker and
more responsive than traditional websites. In this part, you'll learn how to incorporate these
techniques into your ASPNET pages. You'll start with handwritten JavaScript code and the
ASPNET callback feature (in Chapter 34) and then move on to Microsoft’s emerging Atlas
platform (in Chapter 35), which provides a rich API for accessing Ajax features in ASPNET
applications.

What’s New in the Special Edition

When Pro ASPNET 2.0 in VB 2005 was first released, it quickly became the reference of choice
for professional ASPNET developers. But the web development world doesn't stand still—since
the original publication of Pro ASPNET 2.0 in VB 2005, the landscape has continued to change.
Microsoft has released incremental add-ins to Visual Studio (such as Web Application Projects and
Web Deployment Projects, both of which are covered in this book) and is hard at work building the
infrastructure for the next generation of web applications with its Atlas technology. Pro ASPNET 2.0
in VB 2005, Special Edition addresses these areas and adds new content that’s designed to take
developers to the cutting edge of ASPNET development.

Some of the topics that are new to this edition (or greatly expanded) include the following:

¢ Ajax techniques, including a comparison of do-it-yourself callbacks and the ASPNET client
callback feature (in Chapter 34).

* Atlas, the new ASPNET technology that’s still under development but is already generating
intense excitement among developers. Atlas is a set of client-side libraries and server-side
.NET classes that let you use advanced Ajax techniques to create more responsive ASPNET
pages. You can also use Atlas to produce one-of-a-kind client-side effects such as drag-and-
drop functionality and automatic completion. You'll get the lowdown in Chapter 35.

We made these changes to ensure that this book continues to be the most comprehensive
resource for professional ASPNET developers.

What’s Included on the Bonus CD

This special edition includes a bonus CD with additional content in PDE This content includes the
following:

A carefully selected sampler of chapters from 18 other Pro and Expert books from the Apress
library, including advanced books about ASPNET 2.0 and SQL Server 2005. These chapters
total more than 1,500 information-rich pages in eBook form, with complementary examples
athttp://www.apress.com.

 Thirty-three complete ASPToday.com articles in eBook form. These articles deal with
advanced ASPNET 2.0 and SQL Server 2005 topics.

e Afull selection of our .NET 2.0 road maps that illustrate how you, the reader, can link
together Apress books to chart a path for custom learning.
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Note The bonus CD doesn’t contain the code samples for this book. Instead, these samples are available as a
separate download from http://www.prosetech.comor http://www.apress.com. (See the “Sample Code”
section later in this introduction for more information.) By keeping the sample code separate, we ensure that you
always get the most up-to-date versions, even as prerelease technologies such as Atlas change.

Who Is This Book For?

This book is intended as a primer for professional developers who have a reasonable knowledge of
server-side web development. This book doesn'’t provide an exhaustive look at every ingredient in
the .NET Framework—in fact, such a book would require twice as many pages. Instead, this book
aims to provide a lean, intelligent introduction to ASPNET for professional programmers who don’t
want to rehash the basics. Along the way, you'll focus on other parts of the .NET Framework that
you’ll need in order to build professional web applications, including data access and XML. Using
these features, you'll be able to create next-generation websites with the best tools on hand today.

This book is also relentlessly practical. You won't just learn about features; you'll also learn
about the real-world techniques that can take your website to the next level. Later chapters are dedi-
cated to cutting-edge topics such as custom controls, dynamic graphics, advanced security, and
high-performance data access, all with the goal of giving you everything you need to build profes-
sional web applications.

To get the most from this book, you should be familiar with the syntax of the C# language and
with object-oriented concepts. You don't need to have experience with a previous version of
ASPNET, because all the fundamentals are covered in this book.

What Do You Need to Use This Book?

The main prerequisite for this book is a computer with Visual Studio 2005. Although you could
theoretically write code by hand, the sheer tedium of this and the likelihood of error mean this
approach is never used in a professional environment.

Note You can use the scaled-down Visual Studio Web Developer 2005 Express Edition, but you'll run into sig-
nificant limitations on some of the examples. Most important, you can’t use Visual Studio Web Developer 2005
Express Edition to create class libraries, which are an essential part of modern component-oriented design.

Additionally, to run ASPNET pages, you need Windows 2000 Professional, Windows XP Profes-
sional, Windows 2000 Server, or Windows Server 2003. You also need to install IIS (Internet Informa-
tion Services), the web hosting software that’s part of the Windows operating system, if you want to
create web services or test deployment strategies.

Finally, this book has several examples that use sample databases that are included with
SQL Server to demonstrate data access code, security techniques, and web services. If you use
other relational database engines, the same concepts will apply, but you will need to modify the
example code.
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Customer Support

We always value hearing from our readers, and we want to know what you think about this book—
what you liked, what you didn’t like, and what you think we can do better next time. You can send
your comments by e-mail to feedback@apress. com. Please be sure to mention the book title in your
message.

Sample Code

To download the sample code, visit http://www.prosetech.com or the Source Code/Download sec-
tion of the Apress site at http://www.apress.com. In either case, select this book’s title to download
the sample code, which is compressed in a single ZIP file. Before you use the code, you'll need to
uncompress it using a utility such as WinZip. Code is arranged into separate directories by chapter.
Before using the code, refer to the accompanying readme.txt file for information about other pre-
requisites and considerations.

Errata

We've made every effort to make sure the text and the code contain no errors. However, no one is
perfect, and mistakes do occur. If you find an error in the book, such as a spelling mistake or a faulty
piece of code, we would be grateful to hear about it. By sending in errata, you may save another
reader hours of frustration, and you'll be helping us to provide higher-quality information. Simply
e-mail the problem to support@apress.com, where your information will be checked and posted on
the errata page or used in subsequent editions of the book. You can view errata from the book’s
detail page.
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CHAPTER 1

Introducing ASP.NET

When Microsoft created .NET, it wasn't just dreaming about the future—it was also worrying
about the headaches and limitations of the current generation of web development technologies.
Before you get started with ASPNET 2.0, it helps to take a step back and consider these problems.
You'll then understand the solution that .NET offers.

In this chapter you'll consider the history of web development leading up to ASPNET, take
a whirlwind tour of the most significant features of .NET, and preview the core changes in ASPNET 2.0.
If you're new to ASPNET, this chapter will quickly get you up to speed. On the other hand, if you're
a seasoned .NET developer, you have two choices. Your first option is to read this chapter for a brisk
review of where we are today. Alternatively, you can skip to the section “ASPNET 2.0: The Story Con-
tinues” to preview what ASPNET 2.0 has in store.

The Evolution of Web Development

More than ten years ago, Tim Berners-Lee performed the first transmission across HTTP (Hypertext
Transfer Protocol). Since then, HTTP has become exponentially more popular, expanding beyond

a small group of computer-science visionaries to the personal and business sectors. Today, it’s almost
a household term.

When HTTP was first established, developers faced the challenge of designing applications
that could discover and interact with each other. To help meet these challenges, standards such as
HTML (Hypertext Markup Language) and XML (Extensible Markup Language) were created. HTML
established a simple language that could describe how to display rich documents on virtually any
computer platform. XML created a set of rules for building platform-neutral data formats that dif-
ferent applications could use to exchange information. These standards guaranteed that the Web
could be used by anyone, located anywhere, using any type of computing system.

At the same time, software vendors faced their own challenges. They needed to develop not
only language and programming tools that could integrate with the Web but also entire frameworks
that would allow developers to architect, develop, and deploy these applications easily. Major software
vendors including IBM, Sun Microsystems, and Microsoft rushed to meet this need with a host of
products.

ASPNET 1.0 opened a new chapter in this ongoing arms race. With .NET, Microsoft created an
integrated suite of components that combines the building blocks of the Web—markup languages
and HTTP—with proven object-oriented methodology.
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The Development World Before ASP.NET

Older technologies for server-based web applications rely on scripting languages or proprietary tag-
ging conventions. Most of these web development models just provide clumsy hooks that allow you
to trigger applications or run components on the server. They don’t provide a modern, integrated
framework for web programming.

Overall, most of the web development frameworks that were created before ASPNET fall into
one of two categories:

* Scripts that are interpreted by a server-side resource

¢ Separate, tiny applications that are executed by server-side calls

Classic ASP (Active Server Pages, the version of ASP that predates ASPNET) and ColdFusion fall
into the first category. You, the developer, are responsible for creating a script file that contains
embedded code. The script file is examined by another component, which alternates between ren-
dering ordinary HTML and executing your embedded code. If you've created ASP applications before,
you probably know that scripted applications usually execute at a much slower rate than compiled
applications. Additionally, scripted platforms introduce other problems, such as the lack of ability
to control security settings and inefficient resource usage.

The second approach—used widely by, for example, Perl over CGI (Common Gateway Interface)—
yields an entirely different set of problems. In these frameworks, the web server launches a separate
application to handle the client’s request. That application executes its code and dynamically creates
the HTML that should be sent back to the client. Though these applications execute faster than their
scripted counterparts, they tend to require much more memory. The key problem with this sort of
approach is that the web server needs to create a separate instance of the application for each client
request. This model makes these applications much less scalable in environments with large num-
bers of simultaneous users, unless you code carefully. This type of application can also be quite
difficult to write, debug, and integrate with other components.

ASPNET is far more than a simple evolution of either type of application. Instead, it breaks the
trend with a whole new development model. The difference is that ASPNET is deeply integrated
with its underlying framework. ASPNET is not an extension or modification to the .NET Framework
with loosely coupled hooks into the functionality it provides. Instead, ASPNET is a portion of the
.NET Framework that's managed by the .NET runtime. In essence, ASPNET blurs the line between
application development and web development by extending the tools and technologies previously
monopolized by desktop developers into the web development world.

What'’s Wrong with Classic ASP?

If you've programmed only with classic ASP before, you might wonder why Microsoft changed
everything with ASPNET. Learning a whole new framework isn't trivial, and .NET introduces a slew
of concepts and can pose some serious stumbling blocks.

Overall, classic ASP is a solid tool for developing web applications using Microsoft technologies.
However, as with most development models, ASP solves some problems but also raises a few of its
own. The following sections outline these problems.

Spaghetti Code

If you've created applications with ASP, you've probably seen lengthy pages that contain server-side
script code intermingled with HTML. Consider the following example, which fills an HTML drop-
down list with the results of a database query to get author details from the Pubs database in SQL
Server:
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<%
Set dbConn = Server.CreateObject("ADODB.Connection")
Set rs = Server.CreateObject("ADODB.Recordset")
dbConn.Open "PROVIDER=SQLOLEDB;DATA SOURCE=(local);
DATABASE=Pubs ;User=sa;Password=sa"
%>

<select name="cboAuthors">
<%
rs.Open "SELECT * FROM Authors", dbConn, 3, 3
Do While Not rs.EOF
%>
<option value="<%=rs("au_id")%>"><%=rs("au_lname") & ", " &
rs("au_fname")%></option>
<%
rs.MoveNext
Loop
%>
</select>

This example needs an unimpressive 16 lines of code to generate one simple HTML control.
But what’s worse is the way this style of coding diminishes application performance because it min-
gles HTML and script. When this page is processed by the ASP ISAPI (Internet Server Application
Programming Interface) extension that runs on the web server, the scripting engine needs to switch
on and off multiple times just to handle this single request. This increases the amount of time needed
to process the whole page and send it to the client.

Furthermore, web pages written in this style can easily grow to unmanageable lengths. If you
add your own custom COM components to the puzzle (which are needed to supply functionality ASP
can'’t provide) and aren't careful about how you design your application, the management nightmare
grows. The bottom line is that no matter what approach you take, ASP code tends to become beastly,
long, and incredibly difficult to debug—if you can even get ASP debugging working in your environ-
ment at all.

In ASPNET, these problems don't exist. Web pages are written with traditional object-oriented
concepts in mind. Your web pages contain controls that can be programmed against in a way simi-
lar to desktop applications. This means you don’t need to combine a jumble of HTML markup and
inline code. If you opt to use the code-behind approach when creating ASPNET pages, the code and
presentation are actually placed in two different files; simplifies code maintenance and allows you
to separate the task of web-page design from the heavy-duty work of web coding.

Script Languages

At the time of its creation, ASP seemed like a perfect solution for desktop developers who were mov-
ing to the world of the Web. Rather than requiring programmers to learn a completely new language
or methodology, ASP allowed developers to use familiar languages such as VBScript on a server-based
programming platform. By leveraging the already-popular COM (Component Object Model) pro-
gramming model as a backbone, these scripting languages also acted as a convenient vehicle for
accessing server components and resources. But even though ASP was easy to understand for
developers who were already skilled with scripting languages such as VBScript, this familiarity came
with a price.

Performance wasn't the only problem. Every object or variable used in a classic ASP script is
created as a variant data type. As most Visual Basic programmers know, variant data types are weakly
typed. They require larger amounts of memory, are late-bound, and result in slower performance.
Additionally, the compiler and development tools can't identify them at design time. This made it all
but impossible to create a truly integrated IDE (integrated development environment) that could pro-
vide ASP programmers with anything like the powerful debugging, IntelliSense, and error checking
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found in Visual Basic and Visual C++. And without debugging tools, ASP programmers were hard-
pressed to troubleshoot the problems in their scripts.

ASPNET circumvents all these problems. For starters, ASPNET web pages (and web services)
are executed within the CLR (common language runtime), so they can be authored in any language
that has a CLR-compliant compiler. No longer are you limited to using VBScript or JavaScript—
instead, you can use modern object-oriented languages such as Visual Basic and C#.

It’s also important to note that ASPNET pages are not interpreted but are instead compiled into
assemblies (the .NET term for any unit of compiled code). This is one of the most significant enhance-
ments to Microsoft’s web development model in ASPNET 2.0. What actually happens behind the scenes
is revolutionary. Even if you create your code in Notepad and copy it directly to a virtual directory
on a web server, the application is dynamically compiled as soon as a client accesses it (in previous
versions you had to precompile the application into a DLL), and it is cached for future requests. If
any of the files are modified after this compilation process, the application is recompiled automati-
cally the next time a client requests it.

The Death of COM

Though Microsoft claims undying support for COM, the technology that underlies the Windows
operating system, and almost every application that runs on it, it's obvious that .NET is the start of
a new path for modern development. Future versions of the Windows operating system (including
the elusive Longhorn) will integrate the NET Framework more deeply into the operating system
kernel, making it the first-class language of all application development. And as COM applications
wane in popularity and applications are converted to .NET, classic ASP will become a thing of the
past. Even though .NET includes robust support for COM interoperability, the fact remains that
classic ASP applications have no real place in a .NET world.

ASP.NET 1.0

Microsoft developers have described ASPNET as their chance to “hit the reset button” and start from
scratch with an entirely new, more modern development model. The traditional concepts involved
in creating web applications still hold true in the .NET world. Each web application consists of web
pages. You can render rich HTML and even use JavaScript, create components that encapsulate
programming logic, and tweak and tune your applications using configuration settings. However,
behind the scenes ASPNET works quite differently than traditional scripting technologies such as
classic ASP or PHP (PHP: Hypertext Preprocessor). It’s also much more ambitious than JSP (Java
Server Pages).

Some of the differences between ASPNET and earlier web development platforms include the
following:

* ASPNET features a completely object-oriented programming model, which includes an event-
driven, control-based architecture that encourages code encapsulation and code reuse.

e ASPNET gives you the ability to code in any supported .NET language (including Visual
Basic, C#, J#, and many other languages that have third-party compilers).

* ASPNET is also a platform for building web services, which are reusable units of code that
other applications can call across platform and computer boundaries. You can use a web
service to do everything from web-enabling a desktop application to sharing data with a Java
client running on Unix.

* ASPNET is dedicated to high performance. ASPNET pages and components are compiled
on demand instead of being interpreted every time they’re used. ASPNET also includes,
in ADO.NET, a fine-tuned data access model and flexible data caching to further boost
performance.
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These are only a few of the features, which include enhanced state management, practical data
binding, dynamic graphics, and a robust security model. You'll look at these improvements in detail
in this book and see what ASPNET 2.0 adds to the picture.

Seven Important Facts About ASP.NET

If you're new to ASPNET (or you just want to review a few fundamentals), you'll be interested in the
following sections. They introduce seven touchstones of .NET development.

Fact 1: ASP.NET Is Integrated with the .NET Framework

The .NET Framework is divided into an almost painstaking collection of functional parts, with
a staggering total of more than 7,000 types (the .NET term for classes, structures, interfaces, and
other core programming ingredients). Before you can program any type of .NET application, you
need a basic understanding of those parts—and an understanding of why things are organized the
way they are.

The massive collection of functionality that the .NET Framework provides is organized in a way
that traditional Windows programmers will see as a happy improvement. Each one of the thousands
of data types in the .NET Framework is grouped into a logical, hierarchical container called a name-
space. Different namespaces provide different features. Taken together, the .NET namespaces offer
functionality for nearly every aspect of distributed development from message queuing to security.
This massive toolkit is called the class library.

Interestingly, the way you use the .NET Framework classes in ASPNET is the same as the way
you use them in any other type of .NET application (including a stand-alone Windows application,
aWindows service, a command-line utility, and so on). In other words, .NET gives the same tools to
web developers that it gives to rich client developers.

If you've programmed extensively with ASPNET 1.x, you'll find that the same set of classes is
available in ASPNET 2.0. The difference is that ASPNET 2.0 adds even more classes to the mix, many in
entirely new namespaces for features such as configuration, health monitoring, and personalization.

Tip One of the best resources for learning about new corners of the .NET Framework is the .NET Framework
class library reference, which is part of the MSDN Help library reference. If you have Visual Studio 2005 installed,
you can view the MSDN Help library by selecting Start » Programs » Microsoft Visual Studio 2005 » Microsoft
Visual Studio 2005 Documentation (the exact shortcut depends on your version of Visual Studio). Once you've
loaded the help, you can find class reference information grouped by namespace under the .NET Development »
.NET Framework SDK » Class Library Reference node.

Fact 2: ASP.NET Is Compiled, Not Interpreted

One of the major reasons for performance degradation in ASP scripts is that all ASP web-page code
uses interpreted scripting languages. This means that when your application is executed, a scripting
host on the server machine needs to interpret your code and translate it to lower-level machine code,
line by line. This process is notoriously slow.

Note In fact, in this case the reputation is a little worse than the reality. Interpreted code is certainly slower
than compiled code, but the performance hit isn’t so significant that you can’t build a professional website using ASP.
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ASPNET applications are always compiled—in fact, it’s impossible to execute C# or VB .NET
code without it being compiled first.

ASPNET applications actually go through two stages of compilation. In the first stage, the
C# code you write is compiled into an intermediate language called Microsoft Intermediate
Language (MSIL) code, or just IL. This first step is the fundamental reason that .NET can be language-
interdependent. Essentially, all .NET languages (including C#, Visual Basic, and many more) are
compiled into virtually identical IL code. This first compilation step may happen automatically when
the page is first requested, or you can perform it in advance (a process known as precompiling). The
compiled file with IL code is an assembly.

The second level of compilation happens just before the page is actually executed. At this point,
the IL code is compiled into low-level native machine code. This stage is known as just-in-time (JIT)
compilation, and it takes place in the same way for all .NET applications (including Windows appli-
cations, for example). Figure 1-1 shows this two-step compilation process.

.NET compilation is decoupled into two steps in order to offer developers the most convenience
and the best portability. Before a compiler can create low-level machine code, it needs to know what
type of operating system and hardware platform the application will run on (for example, 32-bit or
64-bit Windows). By having two compile stages, you can create a compiled assembly with .NET code
but still distribute this to more than one platform.
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Figure 1-1. Compilation in an ASPNET web page
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Note One day soon, this model may even help business programmers deploy applications to non-Microsoft
operating systems such as Linux. This ambitious goal hasn’t quite been realized yet, but if you'd like to try the
first version of .NET for the Linux platform (complete with a work-in-progress implementation of ASP.NET), visit
http://www.go-mono.com to download the latest version of this open-source effort.

Of course, JIT compilation probably wouldn't be that useful if it needed to be performed every
time a user requested a web page from your site. Fortunately, ASPNET applications don't need to be
compiled every time a web page or web service is requested. Instead, the IL code is created once and
regenerated only when the source is modified. Similarly, the native machine code files are cached in
a system directory that has a path like c:\[WinDir]\Microsoft. NET\Framework\[Version]\Temporary
ASPNET Files, where [WinDir] in the Windows directory and [Version] is the version number for the
currently installed version of the .NET Framework.

Note Although benchmarks are often controversial, you can find an interesting comparison of Java and ASPNET
athttp://gotdotnet.com/team/compare. Keep in mind that the real issues limiting performance are usually
related to specific bottlenecks, such as disk access, CPU use, network bandwidth, and so on. In many benchmarks,
ASP.NET outperforms other solutions because of its support for performance-enhancing platform features such as
caching, not because of the speed boost that results from compiled code.

Although the compilation model in ASPNET 2.0 remains essentially the same, it has one impor-
tant change. The design tool (Visual Studio 2005) no longer compiles code by default. Instead, your
web pages and services are compiled the first time you run them, which improves the debugging
experience. To avoid the overhead of first-time compilation when you deploy a finished application
(and prevent other people from tampering with your code), you can use a new precompilation
feature, which is explained in Chapter 18.

Fact 3: ASP.NET Is Multilanguage

Though you'll probably opt to use one language over another when you develop an application,
that choice won't determine what you can accomplish with your web applications. That’s because
no matter what language you use, the code is compiled into IL.

IL is a stepping-stone for every managed application. (A managed application is any application
that’s written for .NET and executes inside the managed environment of the CLR.) In a sense, IL is
thelanguage of .NET, and it’s the only language that the CLR recognizes.

To understand IL, it helps to consider a simple example. Take a look at this example, written in
VB .NET:

Namespace HelloWorld
Public Class TestClass
Private Shared Sub Main(Args() As String)
Console.WritelLine("Hello World")
End Sub
End Class
End Namespace

This code shows the most basic application that’s possible in .NET—a simple command-line
utility that displays a single, predictable message on the console window.
Now look at it from a different perspective. Here’s the IL code for the Main method:
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.method public static void Main() cil managed

{
.entrypoint
.custom instance void [mscorlib]System.STAThreadAttribute::.ctor() =
( 01 00 00 00 )
// Code size 14 (Oxe)
.maxstack 8
IL_0000: nop
IL 0001: ldstr "Hello World"
IL_0006: call void [mscorlib]System.Console::WriteLine(string)
IL_ooob: nop
IL_000c: nop
IL_oood: ret

} // end of method TestClass::Main

It’s easy enough to look at the IL for any compiled .NET application. You simply need to run the
IL Disassembler, which is installed with Visual Studio and the .NET SDK (software development kit).
Look for the file ildasm.exe in a directory like c:\Program Files\Microsoft Visual Studio 8\SDK\v2.0\Bin.
Once you've loaded the program, use the File » Open command, and select any DLL or EXE that
was created with .NET.

If you're patient and a little logical, you can deconstruct the IL code fairly easily and figure out
what’s happening. The fact that IL is so easy to disassemble can raise privacy and code control
issues, but these issues usually aren’t of any concern to ASPNET developers. That’s because all
ASPNET code is stored and executed on the server. Because the client never receives the compiled
code file, the client has no opportunity to decompile it. If it is a concern, consider using an obfusca-
tor that scrambles code to try to make it more difficult to understand. (For example, an obfuscator
might rename all variables to have generic, meaningless names such asf__a__234.) Visual Studio
includes a scaled-down version of one popular obfuscator, called Dotfuscator.

The following code shows the same console application in C#:

namespace HelloWorld

{
public class TestClass
{
private static void Main(string[] args)
{
Console.WritelLine("Hello World");
}
}
}

If you compile this application and look at the IL code, you'll find that every line is semantically
equivalent to the IL code generated from the VB .NET version. Although different compilers can
sometimes introduce their own optimizations, as a general rule of thumb no .NET language outper-
forms any other .NET language, because they all share the same common infrastructure. This
infrastructure is formalized in the CLS (Common Language Specification), which is described in
the “The Common Language Specification” sidebar.

It’s important to note that IL was recently adopted as an ANSI (American National Standards
Institute) standard. This adoption could quite possibly spur the adoption of other common language
frameworks. The Mono project at http://www.go-mono.comis an example of one such project.
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THE COMMON LANGUAGE SPECIFICATION

The CLS defines the standard properties that all objects must contain in order to communicate with one another in
a homogenous environment. To allow this communication, the CLR expects all objects to adhere to a specific set
of rules.

The CLS is this set of rules. It defines many laws that all languages must follow, such as types, primitive
types, method overloading, and so on. Any compiler that generates IL code to be executed in the CLR must adhere
to all rules governed within the CLS. The CLS gives developers, vendors, and software manufacturers the opportu-
nity to work within a common set of specifications for languages, compilers, and data types. As time goes on, you'll
see more CLS-compliant languages and compilers emerge, although several are available so far.

Given these criteria, the creation of a language compiler that generates true CLR-compliant code can be com-
plex. Nevertheless, compilers can exist for virtually any language, and chances are that there may eventually be one
for just about every language you’d ever want to use. Imagine—mainframe programmers who loved COBOL in its
heyday can now use their knowledge base to create web applications!

Fact 4: ASP.NET Runs Inside the Common Language Runtime

Perhaps the most important aspect of ASPNET to remember is that it runs inside the runtime
engine of the CLR. The whole of the .NET Framework—that is, all namespaces, applications, and
classes—are referred to as managed code. Though a full-blown investigation of the CLR is beyond
the scope of this chapter, some of the benefits are as follows:

Automatic memory management and garbage collection: Every time your application creates an
instance of a class, the CLR allocates space on the managed heap for that object. However, you
never need to clear this memory manually. As soon as your reference to an object goes out of
scope (or your application ends), the object becomes available for garbage collection. The garbage
collector runs periodically inside the CLR, automatically reclaiming unused memory for inacces-
sible objects. This model saves you from the low-level complexities of C++ memory handling
and from the quirkiness of COM reference counting.

Type safety: When you compile an application, .NET adds information to your assembly that
indicates details such as the available classes, their members, their data types, and so on. As
aresult, your compiled code assemblies are completely self-sufficient. Other people can use
them without requiring any other support files, and the compiler can verify that every call is
valid at runtime. This extra layer of safety completely obliterates low-level errors such as the
infamous buffer overflow in C++.

Extensible metadata: The information about classes and members is only one of the types of
metadata that .NET stores in a compiled assembly. Metadata describes your code and allows
you to provide additional information to the runtime or other services. For example, this meta-
data might tell a debugger how to trace your code, or it might tell Visual Studio how to display
a custom control at design time. You could also use metadata to enable other runtime services
(such as web methods or COM+ services).

Structured error handling: If you've ever written any moderately useful Visual Basic or VBScript
code, you'll most likely be familiar with the limited resources these languages offer for error
handling. With structured exception handling, you can organize your error-handling code logi-
cally and concisely. You can create separate blocks to deal with different types of errors. You can
also nest exception handlers multiple layers deep.

Multithreading: The CLR provides a pool of threads that various classes can use. For example,
you can call methods, read files, or communicate with web services asynchronously, without
needing to explicitly create new threads.

Figure 1-2 shows a high-level look at the CLR and the .NET Framework.
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Figure 1-2. The CLR and .NET Framework

Fact 5: ASP.NET Is Object-Oriented

ASP provides a relatively lightweight object model, albeit one that is extensible using heavy COM
objects. It provides a small set of objects; these objects are really just a thin layer over the raw details
of HTTP and HTML. On the other hand, ASPNET is truly object-oriented. Not only does your code
have full access to all objects in the .NET Framework, but you can also exploit all the conventions of
an OOP (object-oriented programming) environment, such as encapsulation and inheritance. For
example, you can create reusable classes, standardize code with interfaces, and bundle useful func-
tionality in a distributable, compiled component.

One of the best examples of object-oriented thinking in ASPNET is found in server-based controls.
Server-based controls are the epitome of encapsulation. Developers can manipulate server controls
programmatically using code to customize their appearance, provide data to display, and even react
to events. The low-level HTML details are hidden away behind the scenes. Instead of forcing the devel-
oper to write raw HTML manually, the control objects render themselves to HTML when the page is
finished rendering. In this way, ASPNET offers server controls as a way to abstract the low-level details
of HTML and HTTP programming.
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Here’s a quick example with a standard HTML text box in an ASPNET web page:
<input type="text" id="myText" runat="server" />

With the addition of the runat="server" attribute, this static piece of HTML becomes a fully
functional server-side control that you can manipulate in your code. You can now work with server-
side events that it generates, set attributes, and bind it to a data source.

For example, you can set the text of this box when the page first loads using the following code:

Private Sub Page Load(ByVal sender As Object, ByVal e As EventArgs) Handles Me.Load
myText.Value = "Hello World!"
End Sub

Technically, this code sets the Value property of an HtmlInputText object. The end result is that
a string of text appears in a text box on the HTML page that’s rendered and sent to the client.

HTML CONTROLS VS. WEB CONTROLS

When ASP.NET was first created, two schools of thought existed. Some ASP.NET developers were most interested in
server-side controls that matched the existing set of HTML controls exactly. This approach allows you to create
ASP.NET web-page interfaces in dedicated HTML editors, and it provides a quick migration path for existing ASP
pages. However, another set of ASP.NET developers saw the promise of something more—rich server-side controls
that didn’t just emulate individual HTML tags. These controls might render their interface from dozens of distinct
HTML elements while still providing a simple object-based interface to the programmer. Using this model, develop-
ers could work with programmable menus, calendars, data lists, and validators.

After some deliberation, Microsoft decided to provide both models. You've already seen an example of HTML
server controls, which map directly to the basic set of HTML tags. Along with these are ASPNET web controls, which
provide a higher level of abstraction and more functionality. In most cases, you’ll use HTML server-side controls for
backward compatibility and quick migration and use web controls for new projects.

ASP.NET web control tags always start with the prefix asp: followed by the class name. For example, the fol-
lowing snippet creates a text box and a check box:

<asp:TextBox ID="myASPText" Text="Hello ASP.NET TextBox" runat="server" />
<asp:CheckBox ID="myASPCheck" Text="My CheckBox" runat="server" />

Again, you can interact with these controls in your code, as follows:

myASPText.Text = "New text"
myASPCheck.Text = "Check me!"

Notice that the Value property you saw with the HTML control has been replaced with a Text property. The
HtmlInputText.Value property was named to match the underlying value attribute in the HTML <input> tag.
However, web controls don’t place the same emphasis on correlating with HTML syntax, so the more descriptive
property name Text is used instead.

The ASP.NET family of web controls includes complex rendered controls (such as the Calendar and TreeView),
along with more streamlined controls (such as TextBox, Label, and Button), which map closely to existing HTML
tags. In the latter case, the HTML server-side control and the ASP.NET web control variants provide similar function-
ality, although the web controls tend to expose a more standardized, streamlined interface. This makes the web
controls easy to learn, and it also means they’re a natural fit for Windows developers moving to the world of the
Web, because many of the property names are similar to the corresponding Windows controls.
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Fact 6: ASP.NET Is Multidevice and Multibrowser

One of the greatest challenges web developers face is the wide variety of browsers they need to support.
Different browser brands, versions, and configurations differ in their support of HTML. Web devel-
opers need to choose whether they should render their content according to HTML 3.2, HTML 4.0,
or something else entirely—such as XHTML 1.0 or even WML (Wireless Markup Language) for mobile
devices. This problem, fueled by the various browser companies, has plagued developers since the
World Wide Web Consortium proposed the first version of HTML. Life gets even more complicated
if you want to use a client-side HTML extension such as JavaScript to create a more dynamic page
or provide validation.

ASPNET addresses this problem in a remarkably intelligent way. Although you can retrieve
information about the client browser and its capabilities in an ASPNET page, ASPNET actually
encourages developers to ignore these considerations and use a rich suite of web server controls.
These server controls render their HTML adaptively by taking the client’s capabilities into account.
One example is ASPNET’s validation controls, which use JavaScript and DHTML (Dynamic HTML)
to enhance their behavior if the client supports it. This allows the validation controls to show dynamic
error messages without the user needing to send the page back to the server for more processing.
These features are optional, but they demonstrate how intelligent controls can make the most of
cutting-edge browsers without shutting out other clients. Best of all, you don’t need any extra coding
work to support both types of client.

Note Unfortunately, ASPNET 2.0 still hasn’t managed to integrate mobile controls into the picture. As a result, if
you want to create web pages for smart devices such as mobile phones, PDAs (personal digital assistants), and so
on, you need to use a similar but separate toolkit. The architects of ASP.NET originally planned to unify these two
models so that the standard set of server controls could render markup using a scaled-down standard such as
WML or HDML (Handheld Device Markup Language) instead of HTML. However, this feature was cut late in the
beta cycle.

Fact 7: ASP.NET Is Easy to Deploy and Configure

One of the biggest headaches a web developer faces during a development cycle is deploying

a completed application to a production server. Not only do the web-page files, databases, and
components need to be transferred, but you also need to register components and re-create a slew
of configuration settings. ASPNET simplifies this process considerably.

Every installation of the .NET Framework provides the same core classes. As a result, deploying
an ASPNET application is relatively simple. In most cases, you simply need to copy all the files to
avirtual directory on a production server (using an FTP program or even a command-line command
like XCOPY). As long as the host machine has the .NET Framework, there are no time-consuming
registration steps.

Distributing the components your application uses is just as easy. All you need to do is copy the
component assemblies when you deploy your web application. Because all the information about
your component is stored directly in the assembly file metadata, there’s no need to launch a registra-
tion program or modify the Windows registry. As long as you place these components in the correct
place (the Bin subdirectory of the web application directory), the ASPNET engine automatically
detects them and makes them available to your web-page code. Try that with a traditional COM
component!

Configuration is another challenge with application deployment, particularly if you need to trans-
fer security information such as user accounts and user privileges. ASPNET makes this deployment
process easier by minimizing the dependence on settings in IIS (Internet Information Services).
Instead, most ASPNET settings are stored in a dedicated web.config file. The web.config file is placed
in the same directory as your web pages. It contains a hierarchical grouping of application settings
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stored in an easily readable XML format that you can edit using nothing more than a text editor such
as Notepad. When you modify an application setting, ASPNET notices that change and smoothly
restarts the application in a new application domain (keeping the existing application domain alive
long enough to finish processing any outstanding requests). The web.config file is never locked, so it
can be updated at any time.

ASP.NET 2.0: The Story Continues

When Microsoft released ASPNET 1.0, even it didn’t anticipate how enthusiastically the technology
would be adopted. ASPNET quickly became the standard for developing web applications with
Microsoft technologies and a heavy-hitting competitor against all other web development platforms.

Note Adoption statistics are always contentious, but the highly regarded Internet analysis company Netcraft
(http://www.netcraft.com) suggests that ASP.NET usage doubled in one year and that it now runs on more
web servers than JSP. This survey doesn’t weigh the relative size of these websites, but ASP.NET powers the web-
sites for a significant number of Fortune 1000 companies.

It’s a testament to the good design of ASPNET 1.0 and 1.1 that few changes in ASPNET 2.0 are
fixes for existing features. Instead, ASPNET 2.0 keeps the same underlying plumbing and concen-
trates on adding new, higher-level features. In other words, ASPNET 2.0 contains more features,
frills, and tools, all of which increase developer productivity. The goal, as stated by the ASPNET
team, is to reduce the number of lines of code you need to write by 70 percent.

Note In reality, professional web applications probably won’t achieve the 70 percent code reduction. However,
you’ll probably be surprised to find new features that you can drop into your applications with only a few minor
tweaks. And unlike many half-baked frills, you won’t need to abandon these features and start from scratch to cre-
ate a real-world application. Instead, you can plug your own modules directly into the existing framework, saving
time and improving the flexibility and reusability of the end result.

Officially, ASPNET 2.0 is backward compatible with ASPNET 1.0. In reality, 100 percent back-
ward compatibility never exists, because correcting bugs and inconsistencies in the language can
change how existing code works. Microsoft maintains a list of the breaking changes (most of which
are very obscure) at http://www.gotdotnet.com/team/changeinfo/Backwards1.1to2.0. However, you're
unlikely to run into a problem when migrating an ASPNET 1.x project to ASPNET 2.0. It’s much more
likely that you'll find some cases where the old way of solving a problem still works but ASPNET 2.0
introduces a much better approach. In these cases, it’s up to you whether to defer the change or try
to reimplement your web application to take advantage of the new features.

Of course, ASPNET 2.0 isn’t just about adding features. It also streamlines performance and
simplifies configuration with a new tool called the WAT (website administration tool). The following
sections introduce some of the most important changes in the different parts of the NET Framework.

Visual Basic 2005

Visual Basic 2005 has several new language features. Some of these are exotic features that only
a language aficionado will love, and others are more generally useful. The new features include the
following:
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Partial classes: Partial classes allow you to split a class into two or more source code files. This
feature is primarily useful for hiding messy details you don't need to see. Visual Studio uses
partial classes in some project types to tuck automatically generated code out of sight.

Generics: Generics allow you to create classes that are flexible enough to work with different class
types but still support strong type checking. For example, you could code a collection class using
generics that can store any type of object. When you create an instance of the collection, you
“lock it in” to the class of your choice so that it can store only a single type of data. The impor-
tant part in this example is that the locking happens when you instantiate the collection class,
not when you code it.

Anonymous methods: Anonymous methods allow you to define a block of code on the fly, inside
another method. You can use this technique to quickly hook up an event handler.

The My object: This object encapsulates some of the most common functionality used by devel-
opers. It exposes several different objects such as My.Application and My.Computer.

You'll see partial classes in action in Chapter 2, and you'll use generic classes with collections
later in this book.

Visual Studio 2005

Microsoft provided two separate design tools for creating web applications with ASPNET 1.x—the
full-featured Visual Studio .NET and the free Web Matrix. Professional developers strongly favored
Visual Studio .NET, but Web Matrix offered a few innovative features of its own. Because Web Matrix
included its own scaled-down web server, programmers could create and test web applications with-
out needing to worry about configuring virtual directories on their computer using IIS.

With .NET 2.0, Web Matrix disappears, but Visual Studio steals some of its best features, including
the integrated web server, which lets you get up and running with a test website in no time, without
the need for IIS or virtual directories on your development machine.

Another welcome change in Visual Studio 2005 is the support for different coding models. While
Visual Studio .NET 2003 locked developers into one approach, Visual Studio 2005 supports a range
of different coding models, making it a flexible, all-purpose design tool. That means you can choose
to put your HTML tags and event-handling code in the same file, or in separate files, without com-
promising your ability to use Visual Studio and benefit from helpful features such as IntelliSense.
(You'll learn about this distinction in Chapter 2.) You can also use more than one programming
language in the same project, mixing C# web pages with VB web pages, or vice versa.

ASP.NET 2.0

For the most part, this book won't distinguish between the features that are new in ASPNET 2.0 and
those that have existed since ASPNET 1.0. However, in the next few sections you'll tour some of the
highlights.

Master Pages

Need to implement a consistent look across multiple pages? With master pages, you can define
a template and reuse it effortlessly. For example, you could use a template to ensure that every web
page in your application has the same header, footer, and navigation controls.

Master pages define specific editable regions, called content regions. Each page that uses the
master page acquires its layout and its fixed elements automatically and supplies the content for
just these regions.

Figure 1-3 shows an example content page at design time. The master page supplies the header
and formatting of the outlying page. The content page is limited to inserting additional HTML and
web controls in a specific region.
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Figure 1-3. A content page at design time

On a related note, ASPNET also adds a new theme feature, which lets you define a standardized
set of appearance characteristics for web controls. Once you've defined these formatting presets,
you can apply them across your website for a consistent look.

Interestingly, you can set both master and themes pages at runtime. This means you can write
code to apply different themes and master pages depending on the type of user or on the user’s
preferences. In this way, you can use master pages and themes not just to standardize your website
but to make it customizable. You'll learn about master pages and themes in Chapter 15.

Data Source Controls

Tired of managing the retrieval, format, and display of your data? With the new data source control
model, you can define how your page interacts with a data source declaratively in your page, rather
than writing the same boilerplate code to access your data objects. Best of all, this feature doesn’t
force you to abandon good component-based design—you can bind to a custom data component
just as easily as you bind directly to the database.

Here’s how the new data-binding model works at its simplest. First, drop the GridView onto
a page using Visual Studio, or code it by hand using this tag:

<asp:Gridview id="MyDataGrid" runat="server"/>

Next, you need to add the data source, which will fetch the rows you're interested in and make
them available to the GridView. This simple example uses the SqlDataSource to connect directly to
a SQL Server database, but a professional application will usually use the ObjectDataSource to go
through a separate layer of custom components. To create the SqlDataSource tag, you need a few
details, including the query used to retrieve the records and the connection string used to access
the database. You can walk through this process with a Visual Studio wizard, or you can code it by
hand. Either way, you'll end up with something like this (assuming that the SQL Server database you
want to connect to is on the current computer and supports Windows authentication):

<asp:SqlDataSource ID="CustomersList" Runat="server"
SelectCommand="SELECT CompanyName, ContactName, ContactTitle, City FROM Customers"
ConnectionString=
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"Data Source=127.0.0.1;Integrated Security=SSPI;Initial Catalog=Northwind">
</asp:SqlDataSource>

This data source defines a connection to the Northwind database and a Select operation that
retrieves all the records in the Customers table.

Finally, you need to bind the data source to the GridView. To do this, set the GridView.DataSourceID
property to the name of the SqlDataSource (in this example, CustomersList). You can do this in code
or using the Visual Studio properties window, in which case you modify the GridView tag to look like
this:

<asp:GridView id="MyDataGrid" DataSourceID="CustomersList" runat="server"/>

Without writing any code or adding special formatting to the GridView control (and there are a lot
of options for doing exactly that), you'll see the bare-bones table in Figure 1-4. On top of this basic
representation, you can define values for features such as font styling, background colors, header
styles, and much more. You can also enable features for column-based sorting, paging (splitting a table
over multiple pages), selecting, and editing.
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Figure 1-4. A simple data-bound grid

Along with the GridView, ASPNET 2.0 also adds other new controls for displaying data, includ-
ing the DetailsView and FormView controls. Both controls can act as a record browser, showing
detailed information for a single record at a time. They also support editing. You'll learn about the
new data features throughout Part 2.

Personalization

Most web applications deal extensively with user-specific data. For example, if you're building an
e-commerce site, you might need to store and retrieve the current user’s address, viewing preferences,
shopping basket, and so on. ASPNET 1.x allowed you to cache this information for a short amount
of time, but it was still up to you to write this information to a database if you needed it for a longer
period of time and then retrieve it later.
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ASPNET 2.0 addresses this limitation with profile, an API for dealing with user-specific informa-
tion that’s stored in a database. The idea is that ASPNET creates a profile object where you can
access the user-specific information at any time. Behind the scenes, ASPNET takes care of the
tedious work of retrieving the profile data when it's needed and saving the profile data when it changes.

Most serious developers will quickly realize that the default implementation of profiles is a
one-size-fits-all solution that probably won't suit their needs. For example, what if you need to use
existing database tables, store encrypted information, or customize how large amounts of data are
cached to improve performance? Interestingly, you can customize the profile feature to suit your
needs by building your own profile provider. This allows you to use the convenient profile features
but still control the low-level details. Of course, the drawback is that you're still responsible for
some of the heavy lifting (no more 70 percent code reduction), but you gain the flexibility and con-
sistency of the profile model. You'll learn about profiles in Chapter 24.

Tip Many of the features in ASP.NET 2.0 work through an abstraction called the provider model. The beauty of
the provider model is that you can use the simple providers to build your page code. If your requirements change,
you don’t need to change a single page—instead, you simply need to create a custom provider. The provider
model is useful enough that a similar organization pattern was used for similar handcrafted solutions in the first
edition of this book, before ASP.NET 2.0 appeared.

Security and Membership

One of the most useful features in ASPNET 1.x was forms authentication, a cookie-based system for
tracking authenticated users. Although forms authentication worked perfectly well for securing
a website, it was still up to each web developer to write the code for authenticating the user in a login
page. And forms authentication didn't provide any functionality for user authorization (testing if the
current user has a certain set of permissions), which meant developers were forced to add these fea-
tures from scratch if they were needed.

ASPNET 2.0 addresses both of these shortcomings by extending forms authentication with new
features. First, ASPNET includes automatic support for tracking user credentials, securely storing
passwords, and authenticating users in a login page. You can customize this functionality based on
your existing tables, or you can simply point ASPNET to your database server and let it manage every-
thing. Additionally, ASPNET includes a handful of new controls for managing security, allowing users
to log in, register, and retrieve passwords. You can let these controls work on their own without any
custom code, or you can configure them to match your requirements.

Finally, ASPNET adds support for authorization with a membership API. Membership allows you
to use role-based authorization. You map your users into different groups (like Guest, Administrator,
SalesEmployee) and then you test if a user is a member of the right group before allowing a specific
action. Best of all, membership plugs right into the forms-based security infrastructure. You'll learn
much more in Part 4.

Rich Controls

All in all, ASPNET introduces more than 40 controls. Many of these controls support new features,
such as the dedicated security controls and web parts controls for portals. You'll also find a handy
wizard and MultiView control that allow you to create pages with multiple views. But the two most
impressive controls are probably the new TreeView and JavaScript-powered Menu.

The TreeView allows you to show a hierarchical, collapsible tree view of data with extensive
customization. Figure 1-5 shows a few of your menu options for outfitting the TreeView with differ-
ent node pictures.

19



20

CHAPTER 1 © INTRODUCING ASP.NET

ntitled Page - Microsoft Internet Explorer

=, »
File Edit Wiew Favorites Tools  Help €] O -3 o 2 search -.?
Address |@ http: fflocalhost: 2857 /Chapter 16/ TreeviewFormats, aspx A |
) A~
= Root (3 Roat = ' Root P
First Child (3] First. Child [Z] First Child
Second Child @ Second Child Ej Second Child
Marrnal windows Help ®P File Explorer
= OF Root & Root = & Root
¥ First Child [ First Child B First Child
¥ Second Child [J second child & second Child
Mews MSDN Inbaox
= L‘L\‘J Rook - Root = Root
@ First Child b First Child /A First Child
@ Second Child b Second Child A\ Second child
Arrows
FAQ Events
+ Root % Root = Root
< First Child __i First Child m First Child
< Second Child __i Second Child m Second Child
Bulleted List Contacts Simple B |
A
< J 2
&) &J Local intranet

Figure 1-5. Node styles with the new TreeView control

The new Menu control also deals with displaying hierarchical data, but it renders itself as
a JavaScript-powered fly-out menu. As you move the mouse, the appropriate submenu appears,
superimposed over the current page (see Figure 1-6).
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Figure 1-6. The dynamic Menu control
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Both the TreeView and the Menu are useful for displaying arbitrary data and for showing a nav-
igation tree so that users can surf from one page to another on your website. To make navigation
even easier, ASPNET also adds an optional model for creating site maps that describe your website.
Once you create a site map, you can use it with the new navigation seamlessly. Best of all, from that
point on you can change the structure of your website or add new pages without needing to modify
anything other than a single site-mabp file. You'll see the navigation controls in action in Chapter 16.

Web Parts

One common type of web application is the portal, which centralizes different information using
separate panes on a single web page. Although you could create a portal website in ASPNET 1.x,
you needed to do it by hand. In ASPNET 2.0, a new web parts feature makes life dramatically easier
with a prebuilt portal framework. And what a model it is—complete with a flow-based layout, con-
figurable views, and even drag-and-drop support. Indeed, if you're planning to create a web portal
with these features, it’s safe to say that ASPNET 2.0 will deliver the promised 70 percent code savings.
You'll see more of this advanced feature in Chapter 30.

Administration

To configure an application in ASPNET 1.x, you needed to edit a configuration file by hand. Although
this process wasn'’t too difficult, ASPNET 2.0 streamlines it with a dedicated web administration tool
that works through a web-page interface. This tool, called the WAT, is particularly useful if you're also
using the personalization and membership features. That’s because the WAT gives you a convenient
(if slightly sluggish) interface for defining user-specific data, adding users, assigning users to roles,
and more. You'll take your first look at the WAT in Chapter 5.

Summary

So far, you've only just scratched the surface of the features and frills that are provided in ASPNET and
the .NET Framework. You've taken a quick look at the high-level concepts you need to understand in
order to be a competent ASPNET programmer. You've also previewed the new features that ASPNET 2.0
offers. As you continue through this book, you'll learn much more about the innovations and revo-
lutions of ASPNET 2.0 and the .NET Framework.






CHAPTER 2

Visual Studio 2005

With ASPNET, you have several choices for developing web applications. If you're inclined (and
don’t mind the work), you can code every web page and class by hand using a bare-bones text editor.
This approach is appealingly straightforward but tedious and error-prone for anything other than
a simple page. Professional ASPNET developers rarely go this route.

Instead, almost all large-scale ASPNET websites are built using Visual Studio. This professional
development tool supports a rich set of design tools, including a legendary set of debugging tools and
IntelliSense, which catches errors and offers suggestions as you type. Visual Studio also supports the
robust code-behind model, which separates the .NET code you write from the web-page markup
tags. To seal the deal, Visual Studio 2005 adds a built-in test web server that makes debugging Web
sites easy and relatively hassle-free.

In this chapter, you'll tour the Visual Studio IDE and explore its key features. You'll also learn
about the coding model used for ASPNET 2.0 web pages.

Note Visual Studio 2005 is available in several versions. This chapter assumes you are using the full Visual Studio
2005 Professional or Visual Studio 2005 Team System. If you are using the scaled-down Visual Web Developer 2005
Express Edition, you will lose some features. Most notably, you won't be able to create separate components with
class library projects.
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VISUAL STUDIO 2005 CHANGES

If you're a seasoned ASP.NET developer, you’re most interested in what’s new in Visual Studio 2005. Although most
of the editing features and debugging tools in Visual Studio 2005 are the same as those in Visual Studio 2003, the
underlying model has a few significant changes. Here are the four most significant changes, all of which you’ll learn
more about in this chapter:

* Projectless development: Visual Studio no longer clutters your web projects with extra development files
(such as .vbproj and .sIn). One obvious benefit of this model is that you can deploy exactly what you develop,
without needing to filter out just a subset of the files. However, as you'll see in this chapter, the concept of
projectless development is slightly overstated. Visual Studio still stores some information in a solution file
(such as breakpoints and build settings), and it quietly stows that file away under a user-specific directory.
However, there’s a significant difference—these hidden solution files aren’t required. Essential details (such
as project references) are stored right in the web.config file. You'll learn about projectless development in the
“Websites in Visual Studio” section of this chapter.

e New compilation model-Visual Studio is no longer responsible for compiling your code. Instead, ASPNET
takes on that responsibility exclusively. This gives Visual Studio more flexible debugging, and it simplifies
deployment on different platforms (for example, 32-bit and 64-bit Windows). It also allows you to combine
web pages written in C# with web pages written in another .NET language (such as Visual Basic) in the same
project.

e New code model- The shift in the compilation model also reduces the differences between the code-behind
model and the code-inline model of writing web pages, both of which Visual Studio now supports. However,
the syntax for code-behind is subtly different from that used for Visual Studio 2003 web pages, and you’ll
need to perform a one-way conversion operation to edit your web application in Visual Studio 2005. You'll
learn about the coding model in “The Coding Model” later in this chapter.

o Integrated test web server. If you’ve programmed with Web Matrix (a scaled-down design tool used with
ASP.NET 1.x), you'll recognize the new integrated web server, which allows you to run your web pages with-
out setting up virtual directories, deploying your website, or having IIS installed on your development
machine.

Along with these changes, a new edition of Visual Studio, called Visual Studio 2005 Team System, adds
advanced collaboration and code-versioning support (which is far beyond that available in simpler tools such as
Visual SourceSafe). Although Visual Studio Team System isn’t discussed in this chapter, you can learn more from
http://1lab.msdn.microsoft.com/teamsystem or Pro Visual Studio 2005 Team System (Apress, 2005).

Another interesting new tool is the freely downloadable ASP.NET Development Helper, which gives you the
ability to see view state, tracing, and caching information in your web browser. You'll learn about the ASP.NET
Development Helper in the later “ASP.NET Development Helper” section.

The .NET Development Model

To create an ASPNET application in Visual Studio 2005, you need two high-level areas of functionality:

¢ The compiler, which inspects the developer code and translates it into lower-level code (in
this case, IL).

e The IDE, which allows a developer to write code. While not a necessity (you could always use
notepad), thanks to the integrated debugging, deployment and code management features,
the IDE is an indispensably useful application to have.
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The Compiler

.NET separates these two pieces. That way, every language can use the same design tools. The .NET
language compilers include the following:

¢ The Visual Basic compiler (vbc.exe)
¢ The C# compiler (csc.exe)
¢ The JScript compiler (jsc.exe)

* The J# compiler (vjc.exe)

Note For a more-comprehensive list that includes third-party languages, check out http: //www. dotnetpowered.
com/languages.aspx.

If you want to use these compilers manually, you can invoke them from the command line.
You'll find all of them in c:\[WinDir]\Microsoft. NET\[Version], where WinDir is the directory of the
operating system (like c:\Windows) and Version is the version number of .NET you've installed, like
v2.0.50215. However, using the .NET compilers manually is awkward because you need to specify
the files you want to compile and the other .NET assemblies they use. You also need to compile your
entire application at once or compile each web page separately. To avoid these headaches, most
developers rely on ASPNET’s built-in support for compiling pages, or making the most of the pre-
compiling features in Visual Studio 2005.

Note In ASPNET 1.x, Visual Studio used the precompiled code-behind model and was responsible for compiling
all web pages into a single DLL assembly. In Visual Studio 2005, this behavior changes. Now, Visual Studio lets ASPNET
perform the compilation for each page the first time it’s requested. This speeds up debugging and allows you to
create websites that combine pages written in different languages. The original problems that motivated Visual Studio’s
precompilation model—optimizing the performance for the first request and reducing the need to deploy source
code files—can now be solved using ASP.NET’s precompilation features, which you’ll learn about in Chapter 18.

The Visual Studio 2005 IDE

For those who are used to the previous version of the Visual Studio IDE, it’s an obvious choice to use
the new Visual Studio IDE. After all, it offers all the benefits of the previous version but with signifi-
cant advancements in operability, syntax, and integration with other languages. For those who
haven't tried Visual Studio before, the reasons to use Visual Studio may not be immediately obvious.
Some of its advantages include the following:
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WYSIWYG: Who writes HTML pages by hand? Using Visual Studio, you can tweak and fine-tune
even static HTML content, applying fonts and styles.

Less code to write: Most applications require a fair bit of standard boilerplate code, and ASPNET
web pages are no exception. For example, when you add a new control to a web page, you also
need to define a variable that allows you to manipulate that control in your code. With Visual
Studio, these basic tasks are performed for you. Similar automation is provided for connecting
to web services.

Intuitive coding style: By default, Visual Studio formats your code as you type, indenting auto-
matically and using color-coding to distinguish elements such as comments. These minor
differences make code much more readable and less prone to error. You can even configure
what automatic formatting Visual Studio applies, which is great if you prefer different brace
styles (such as K&R style, which always puts the opening brace on the same line as the preced-
ing declaration).

Tip To see the formatting options, select Tools » Options, make sure the Show All Settings check box is
checked, and then find the Text Editor » C# » Formatting group of settings. You’ll see a slew of options that con-
trol where curly braces should be placed.

An integrated web server: To host an ASPNET web application, you need web server software
like IIS, which waits for web requests and serves the appropriate pages. Setting up your web
server isn't difficult, but it is inconvenient. Thanks to the integrated development web server in
Visual Studio, you can run a website directly from the design environment.

Multilanguage development: Visual Studio allows you to code in your language or languages of
choice using the same interface (IDE) at all times. Even better, Visual Studio 2005 adds the abil-
ity to put web pages coded in C# in the same application as web pages written in Visual Basic.
The only limitation is that you can’'t use more than one language in the same web page (which
would create obvious compilation problems).

Faster development times: Many of the features in Visual Studio are geared toward helping you
get your work done faster. Convenience features such as powerful search-and-replace and
automatic comment and uncomment features, which can temporarily hide a block of code,
allow you to work quickly and efficiently.

Debugging: The Visual Studio debugging tools are the best way to track down mysterious
errors and diagnose strange behavior. You can execute your code one line at a time, set intelli-
gent breakpoints that you can save for later use, and view current in-memory information at
any time.

Visual Studio also has a wealth of features that you won'’t see in this chapter, including project
management, integrated source code control, and a rich extensibility model.

Websites in Visual Studio

When the IDE first loads, it shows an initial start page. You can use various user-specific options from
this page and access online information such as recent MSDN articles. But to get right to work, choose
File » New Website to create a new ASPNET application. Visual Studio will then show the New Web
Site dialog box (see Figure 2-1). Notice that you don’t use Visual Studio’s File » New Project command.
That’s because web applications aren'’t projects, as you'll see later in this chapter.
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E‘%ASP‘NET Wb Site S!BASF'.NET Wb Service ,.;;gPersonal Web Site Starter Kit
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My Templates

LESEarch Online Templates...

A blank ASP.NET Vb site |

Location: ‘FI|B System M‘D:\Code\\fvebswtel IL] Browse, ..

l OK H Cancel l

Figure 2-1. The New Web Site window

The New Web Site window allows you to specify three details:

Template: The template determines what files your website starts with. Visual Studio supports
two types of basic ASPNET applications: web site applications and web service applications.
These applications are actually compiled and executed in the same way. In fact, you can add
web pages to a web service application and can add web services to an ordinary web applica-
tion. The only difference is the files that Visual Studio creates by default. In a web application,
you'll start with one sample web page in your project. In a web service application, you'll start
with a sample web service. Additionally, Visual Studio includes more sophisticated templates
for certain types of sites, and you can even create your own templates (or download third-party
offerings).

Location: The location specifies where the website files will be stored. Typically, you'll choose
File System and then use a folder on the local computer or a network path. However, you can
also edit a website directly over HTTP or FTP (File Transfer Protocol). This is occasionally useful
if you want to perform live website edits on a remote web server. However, it also introduces
additional overhead. Of course, you should never edit a production web server directly because
changes are automatic and irreversible. Instead, limit your changes to test servers.

Language: The language identifies the .NET programming language you’ll use to code your
website. The language you choose is simply the default language for the project. This means
you can explicitly add Visual Basic web pages to a C# website, and vice versa (a feat that wasn't
possible with earlier versions of Visual Studio).

Instead of typing the location in hand, you can click the Browse button, which shows the
Choose Location dialog box. Along the left side of Choose Location dialog box you'll see four buttons
that let you connect to different types of locations:
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File System: This is the easiest choice—you simply need to browse through a tree of drives and
directories or through the shares provided by other computers on the network. If you want to
create a new directory for your application, just click the Create New Folder icon above the
top-right corner of the directory tree. (You can also coax Visual Studio into creating a directory
by adding a new directory name to the end of your path.)

Local IIS: This choice allows you to browse the virtual directories made available through the
IIS web hosting software, assuming it’s running on the current computer. Chapter 18 describes
virtual directories in detail and shows you how to create them with IIS Manager. Impressively,
you can also create them in Visual Studio using the Create New Web Application icon at the
top-right corner of the virtual directory tree.

FTP Site: This option isn't quite as convenient as browsing for a directory—instead, you’ll need
to enter all the connection information, including the FTP site, the port, the directory, a user
name, and a password before you can connect.

Remote Web Server: This option accesses a website at a specified URL (uniform resource locator)
using HTTP. For this to work, the web server must have the FrontPage Extensions installed.
When you connect, you'll be prompted for a user name and password.

Figure 2-2 shows all these location types.
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C C
= Selact the Folder you wart to open. = . Selact the W site you wani: to open, P03
File System File System
— (@ veskop - —— | | M Local web Servers -~
() My Documents = e
= g My Computer [ _private
Local 115 1B 3% Floopy (A1) __locallls | [ aspnet_dlent
e < Applications (C1) e) [ aspnet_wehadmin
- =% Documents (D) - 4§ attachmentservice
FIP Site &0 Code = FIP Site £33 bin
@‘i 1) ADO.NETZ @‘i 4§ clickoncesp
o o  sene
Remote Site (44 Chapter02 Remote Site 48} CurrencyConverterl
() Chapterdd
) Chapteros
[#3) Chapters
() Chapterd?
[#{3) Chapter0?
() Chapterto
) Chapter11 =
[#3) Chaptert2
¥ ) Chaoter1d ] 4§ TestappSetup v
: DifCode|ASP.NET Use Secure Sockets Layer
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Username:
Passpord;
4\ Passwards are sert across the networkin plaintext (unencrypted text), making
them vulnerable to interception.

Figure 2-2. Browsing to a website location
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Once you make your selection and click Open, Visual Studio returns you to the Create New Web
Site dialog box. Click OK, and Visual Studio will create the new web application. A new website starts
with a Default.aspx start page and its Default.aspx.vb code-behind file.

Projectless Development

In many ways, Visual Studio 2005 web applications are more remarkable for what they don’t contain
than what they do. Unlike previous versions of Visual Studio, Visual Studio 2005 web applications don’t
include extra files, such as .vbproj project files and .sln solution files. Instead, every file in your web
folder automatically is considered part of the web application.

Clearing out this clutter has several benefits:

* It’sless work to deploy your website, because you don't need to specifically exclude these files.
There’s also less duplication of settings, because most of what Visual Studio needs (such as
assembly references) is stored in the web.config configuration file.

» Team collaboration is greatly simplified, because different people can work independently
on different pages without needing to lock the project files.

* It’s easier to author websites with other tools, because no extra project files need to be
maintained.

* Files can easily be transferred from one web application to another—all you need to do is
copy the file. Do note however, that if it is an .aspx page, you'll likely have to copy the associ-
ated code-behind file.

Although this simplifies life dramatically, under the radar there are still the last vestiges of
Visual Studio’s solution-based system.

When you create a web application, Visual Studio actually creates solution files (.sln and .suo)
in a user-specific directory, like c:\Documents and Settings\[UserName]\Visual Studio 2005
\Projects\[ProjectName]. This file provides a few Visual Studio-specific features that aren’t directly
related to ASPNET, such as debugging settings. For example, if you add a breakpoint to the code in
aweb page (as discussed in the “Visual Studio Debugging” section later in this chapter), Visual Studio
stores the breakpoint in the .suo file so it’s still there when you open the project later. Similarly,
Visual Studio tracks the currently open files so it can restore your view when you return to the proj-
ect. This approach to solution management is fragile—obviously, if you move the project from one
location to another, you lose all this information. However, because this information isn't really all
that important (think of it as a few project-specific preferences), losing it isn’t a serious problem.
The overall benefits of a projectless system are worth the trade-off.

29



30

CHAPTER 2 ' VISUAL STUDIO 2005

Migrating a Visual Studio .NET Project

If you have an existing web application created with Visual Studio .NET 2002 or 2003, you can open
the project or solution file using the File » Open Project command. When you do, Visual Studio
begins the Conversion Wizard.

The Conversion Wizard is exceedingly simple. It prompts you to choose whether to create
a backup and, if so, where it should be placed (see Figure 2-3). If this is your only copy of the appli-
cation, a backup is a good idea in case some aspects of your application can’t be converted
successfully. Otherwise, you can skip this option.

Visual Studio Conversion Wizard

Choose Whether To Create a Backup w

IF wou want a copy of your solution or project in its current Format, it must be backed up,

Do you want to create a backup before converting?
® Mg
() ¥es, create a backup before converting

Location For backup:

[ < Previous ” Mext = ][ Finish ][ Cancel

Figure 2-3. Importing a Visual Studio .NET 2003 project

When you click Finish, Visual Studio performs an in-place conversion. The conversion tool is
fairly aggressive, and it attempts to convert every web page to use Visual Studio’s new code-behind
model. Any errors and warnings are added to a conversion log, which you can display when the
conversion is complete. In a typical website, the conversion operation runs without any errors but
generates a long list of warnings. These inform you when Visual Studio removes precompiled files,
changes pages to use automatic event wire-up, and modifies the accessibility of event handlers
(switching them from Private to Protected). All of these changes are minor modifications designed
to apply the new coding model, which is described in the section “The Coding Model” later in this
chapter. Figure 2-4 shows a sample log.
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Figure 2-4. A conversion log with typical warnings

Visual Studio 2005 doesn’t support adding old web pages to a new web application using the
Website » Add Existing Item. If you take this step and try to run your web application, you'll receive
an error informing you that the Visual Studio .NET 2003 version of the code-behind model is no
longer supported. Instead, Visual Studio will recommend you use the Open Project feature to start
the Conversion Wizard. However, it’s not too difficult to get around this limitation. Simply edit your
.aspx page by changing the Codebehind attribute to Src. In other words, this code:

<%@ Page language="vb" Codebehind="MyPage.aspx.vb"
AutoEventWireup="false" Inherits="MyApp.MyPage" %>

becomes this:

<%@ Page language="vb" Src="MyPage.aspx.vb"
AutoEventWireup="false" Inherits="MyApp.MyPage" %>

This change switches the page so it uses the named code file directly. In most situations, this
tactic isn’'t recommended because it leaves many details of the old coding model intact (such as the
way event handlers are wired up), and it won't catch other problems that could thwart conversion.
However, it’s a good last resort if you want to keep your web page relatively unchanged so that you
can bring it back into the Visual Studio .NET 2003 environment later.

Designing a Web Page

To start designing a web page, double-click the web page in the Solution Explorer (start with
Default.aspx if you haven't added any pages). A blank page will appear in the designer.

To add controls, choose the control type from the Toolbox on the left. (The controls in the Toolbox
are grouped in numerous categories based on their functions, but you'll find basic ingredients in
the Standard tab.) Once you've added a control, you can resize it and configure its properties in the
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Properties window. Every time you add a web control, Visual Studio automatically adds the corre-
sponding tag to your .aspx web-page file. You can switch your view to look at the tags by clicking the
Source button at the bottom of the web designer window. Click Design to revert to the graphical
web form designer.

Figure 2-5 shows two views of the same web page that contain a label and a button. One view is
in HTML mode, and the other is in design mode.

X

Default.aspx*| Start Page =
Client Objects & Events ][ (v Events)
<%@ Page Language="VB" AutoEventWireup="false" CodeFile="Default.as

Default.aspx*| Start Page 3
Label [Button

[ |

<!DOCTYPE htnl PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "htt
[EI<html #mlns="http://unmw.w3.org/1999/xhtnl" >
El<head runat="server">
<titlesUntitled Page</title>
</head>
Bl <body>
c] <form id="forml" runat="server">
o <div>
<asp:Label ID="Labell" runat="server" Text="Label"></asp:le
<asp:Button ID="Buttonl" runat="server" Text="Button" /></d
</forn>
</body>
</htnl>

[el \ B
G Design & Source <html> | <body> || <form #form 1> | [<div>|[<asp:Label#Label 1> [ Desion | @ source <body> || <div>|[<aspbutton#button 1>

Figure 2-5. The fwo modes for editing web pages

Using the HTML view, you can manually add attributes or rearrange controls. In fact, Visual
Studio even provides limited IntelliSense features that automatically complete opening tags and
alert you if you use an invalid tag. Generally, you won't need to use the HTML view in Visual Studio.
Instead, you can use the design view and configure controls through the Properties window.

Note Unlike previous versions, Visual Studio 2005 doesn’t tamper with your HTML markup. Instead, it always
preserves the indenting you use. You can fine-tune this behavior using the Text Editor » HTML group of settings in
the Tools » Options dialog box. For example, one handy option that isn’t turned on by default is Format HTML on
Paste, which indents arbitrary blocks of markup when you paste them into a page.

To configure a control, click once to select it, or choose it by name in the drop-down list at the
top of the Properties window. Then, modify the appropriate properties in the window, such as Text,
ID, and ForeColor. These settings are automatically translated to the corresponding ASPNET control
tag attributes and define the initial appearance of your control. Visual Studio even provides special
“choosers” (technically known as UITypeEditors) that allow you to select extended properties. For
example, you can select a color from a drop-down list that shows you the color, and you can configure
the font from a standard font selection dialog box.

To position a control on the page, you need to use all the usual tricks of HTML, such as paragraphs,
line breaks, and tables. Unlike previous versions, Visual Studio 2005 doesn't support a grid-layout
mode for absolute positioning with CSS (Cascading Style Sheets). Instead, it encourages you to use
the more flexible flow-layout mode, where content can grow and shrink dynamically without creat-
ing a problem. However, there is a way to get back to the grid-layout behavior. All you need to do is
add an inline CSS style for your control that specifies absolute positioning. (This style will already
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exist in any pages you've created with a previous version of Visual Studio .NET in grid-layout mode.)
Here’s an example:

<asp:Button id="cmd" style="POSITION: absolute; left: 100px; top: 50px;"
runat="server" ... />

Once you've made this change, you're free to drag the button around the window at will. Of
course, you shouldn’t go this route just because it seems closer to the Windows GUI (graphical user

interface) model. Few great web pages rely on absolute positioning, because it’s just too awkward
and browser-dependent.

Smart Tags

Another timesaving feature that’s new in Visual Studio 2005 is the smart tag, smart tags make it eas-
ier to configure complex controls. Smart tags aren’t offered for all controls, but they are used for rich
controls such as the GridView, TreeView, and Calendar.

You'll know a smart tag is available if, when you select a control, you see a small arrow in the
top-right corner. If you click this arrow, a window will appear with links that trigger other, higher-
level tasks. For example, Figure 2-6 shows how you can use this technique to access Calendar

autoformatting. (Smart tags can include many more features, but the Calendar smart tag provides
only a single link.)

Calendar.aspx* - X

Hi3l Kl Calendar Tasks
< June 2005 >
Auto Format. ..

Sun Mon Tue Wed Thn Fni  Sat
29 30 3 1 2 3 4
5 6 7 8 g 10 1
12 13 14 15 16 17 18
19 20 21 22 23 24 25
26 27 28 29 30 1 2
3 4 5 6 7 8 9

[#] Source <body = || <div= || <aspicalendar#calendarl =

Figure 2-6. A smart tag for the Calendar control

Static HTML Tags

Along with full-fledged web controls, you can also add ordinary HTML tags. You simply drag these
from the HTML tab of the Toolbox.

For example, you might want to create a simple <div> tag to group some web controls with a bor-
der. Visual Studio provides a valuable style builder for formatting any static HTML element with CSS
style properties. To test it, add the Div from the HTML section of the Toolbox, which appears on your
page as a panel. Then right-click the panel, and choose Style. The Style Builder dialog box (shown in
Figure 2-7) will appear, with options for configuring the colors, font, layout, and border for the element.
As you configure these properties, the web page’s HTML will be updated to reflect your settings.
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Figure 2-7. Building HTML styles

If you want to configure the HTML element as a server control so that you can handle events and
interact with it in code, you need to right-click it in the web page and select Run As Server Control.

This adds the required runat="server" attribute to the control tag. Alternatively, you could switch to
source view and type this in on your own.

HTML Tables

One convenient way to organize content in a web page is to place it in the different cells of an HTML
table using the <table> tag. In previous versions of Visual Studio, the design-time support for this
strategy was poor. But in Visual Studio 2005, life gets easier. To try it, drag a table from the HTML tab
of the Toolbox. You'll start with a standard 3x3 table, but you can quickly transform it using editing

features that more closely resemble a word processor than a programming tool. Here are some of
the tricks you’ll want to use:

To move from one cell to another in the table, press the Tab key or use the arrow keys. The
current cell is highlighted with a blue border. Inside each cell you can type static HTML or
drag and drop controls from the Toolbox.

To add new rows and columns, right-click inside a cell, and choose from one of the many
options in the Insert submenu to insert rows, columns, and individual cells.

* To resize a part of the table, just click and drag.

To format a cell, right-click inside it, and choose Style. This shows the same Style Builder
dialog box you saw in Figure 2-7.

To work with several cells at once, hold down Ctrl while you click each cell. You can then
right-click to perform a batch formatting operation.

To merge cells (in other words, change two cells into one cell that spans two columns), just
select the cells, right-click, and choose Merge.

With these conveniences, you might never need to resort to a design tool like Dreamweaver.



The Visual Studio IDE

Now that you've created a basic website, it’s a good time to take a tour of the different parts of the
Visual Studio interface. Figure 2-8 identifies each part of the Visual Studio window, and Table 2-1
describes each one.
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Figure 2-8. The Visual Studio interface

Table 2-1. Visual Studio Windows

configuration
tool (covered
in Chapter 5)

Click here to
start deploying
the web appli-
cation (see
Chapter 18)

Refresh the
directory view

Macro Explorer

Class View

Windows

Description

Solution Explorer

Toolbox

Lists the files and subfolders that are in the web application folder.

Shows ASPNET’s built-in server controls and any third-party controls or
custom controls that you build yourself and add to the Toolbox. Controls can
be written in any language and used in any language.

(Continued)

35



36

CHAPTER 2 ' VISUAL STUDIO 2005

Table 2-1. Continued

Windows

Description

Server Explorer
Properties
Error List

Task List

Document

Macro Explorer

Class View

Allows access to databases, system services, message queues, and other
server-side resources.

Allows you to configure the currently selected element, whether it’s a file in
the Solution Explorer or a control on the design surface of a web form.

Reports on errors that Visual Studio has detected in your code but that you
haven't resolved yet.

Lists comments that start with a predefined moniker so that you can keep
track of portions of code that you want to change and also jump to the
appropriate position quickly.

Allows you to design a web page by dragging and dropping and to edit the
code files you have within your Solution Explorer. Also supports non-
ASPNET file types, such as static HTML and XML files.

Allows you to see all the macros you've created and execute them. Macros are
an advanced Visual Studio feature; they allow you to automate time-
consuming tasks. Visual Studio exposes a rich extensibility model, and you
can write a macro using pure .NET code.

Shows a different view of your application that is organized to show all the
classes you've created (and their methods, properties, and events).

Tip The Visual Studio interface is highly configurable. You can drag the various windows and dock them to the
sides of the main Visual Studio window. Also, some windows on the side automatically slide into and out of view as
you move your mouse. If you want to freeze these windows in place, just click the thumbtack (or pin) icon in the
top-right corner of the window.

Solution Explorer

The Solution Explorer is, at its most basic, a visual filing system. It allows you to see the files that are
in the web application directory.
Table 2-2 lists some of the file types you're likely to see in an ASPNET web application.

Table 2-2. ASPNET File Types

File

Description

Ends with .aspx

Ends with .ascx

Ends with .asmx

These are ASPNET web pages (the .NET equivalent of the .asp file in an ASP

application). They contain the user interface and, optionally, the underlying
application code. Users request or navigate directly to one of these pages to

start your web application.

These are ASPNET user controls. User controls are similar to web pages,
except that they can’t be accessed directly. Instead, they must be hosted
inside an ASPNET web page. User controls allow you to develop an
important piece of the user interface and reuse it in as many web forms as
you want without repetitive code.

These are ASPNET web services. Web services work differently than web
pages, but they still share the same application resources, configuration
settings, and memory.
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File Description

web.config This is the XML-based configuration file for your ASPNET application. It
includes settings for customizing security, state management, memory
management, and much more. Visual Studio adds a web.config file when you
need it. (For example, it adds a web.config file that supports debugging if you
attempt to run your web application.) When you first create a website, you won't
have a web.config file. You can add a web.config file manually if you need one.

global.asax This is the global application file. You can use this file to define global
variables and react to global events, such as when a web application first
starts (see Chapter 5 for a detailed discussion). Visual Studio doesn’t create
a global.asax file by default—you need to add it if it’s appropriate.

Ends with .vb These are code-behind files that contain C# code. They allow you to separate
the application from the user interface of a web page. The code-behind model
is introduced in this chapter and used extensively in this book.

In addition, your web application can contain other resources that aren't ASPNET file types. For
example, your virtual directory can hold image files, HTML files, or CSS files. These resources might
be used in one of your ASPNET web pages, or they can be used independently.

Visual Studio distinguishes between different file types. When you right-click a file in the list,

a context menu appears with the menu options that apply for that file type. For example, if you
right-click a web page, you'll have the option of building it and launching it in a browser window.

Using the Solution Explorer, you can rename, rearrange, and add files. All these options are just
aright-click away. To delete a file, just select it in the Solution Explorer, and press the Delete key.

You can also add new files by right-clicking the Solution Explorer and selecting Add »
Add New Item. You can add various different types of files, including web forms, web services,
stand-alone classes, and so on. You can also copy files that already exist elsewhere on your computer
(or an accessible network path) by selecting Add » Add Existing Item. Use the Add » New Folder to
create a new subdirectory inside your web application. You can then drag web pages and other files
into or out of this directory.

Visual Studio also checks for project management events such as when another process changes
a file in a project you currently have open.. When this occurs, Visual Studio will notify you and give
you the option to refresh the view of the file in the document window.

Document Window

The document window is the portion of Visual Studio that allows you to edit various types of files
using different designers. Each file type has a default editor. To learn a file’s default editor, simply
right-click the file in the Solution Explorer, and then select Open With from the pop-up menu. The
default editor will have the word Default alongside it.

Depending on the applications you've installed, you may see additional designers that plug into
Visual Studio. For example, if you've installed FrontPage 2003, you'll have the option of editing web pages
with a FrontPage designer (which actually opens your web page in a stand-alone FrontPage window).

Toolbox

The Toolbox works in conjunction with the document window. Its primary use is providing the controls
that you can drag onto the design surface of a web form. However, it also allows you to store code
and HTML snippets.

The content of the Toolbox depends on the current designer you're using as well as the project
type. For example, when designing a web page, you'll see the set of tabs described in Table 2-3. Each
tab contains a group of icons. You can see only one tab at a time. To view a tab, click the heading,
and the icons will slide into view.
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Table 2-3. Toolbox Tabs for an ASPNET Project

Tab Description

Standard This tab includes the rich web server controls that are the heart of ASPNET’s web
form model.

Data These components allow you to connect to a database. This tab includes nonvisual
data source controls that you can drop onto a form and configure at design time
(without using any code) and data display controls such as grids.

Validation These controls allow you to verify an associated input control against user-defined
rules. For example, you can specify the input can’t be empty, it must be a number, it
must be greater than a certain value, and so on. Chapter 4 has more details.

Navigation These controls are designed to display site maps and allow the user to navigate
from one page to another. You'll learn about the navigation controls in Chapter 16.

Login These controls provide prebuilt security solutions, such as login boxes and a wizard
for creating users. You'll learn about the login controls in Chapter 20.

WebParts This set of controls supports web parts, an ASPNET model for building
componentized, highly configurable web portals. You'll learn about WebParts in
Chapter 29.

HTML This tab allows you to drag and drop static HTML elements. If you want, you can

also use this tab to create server-side HTML controls—just drop a static HTML
element onto a page, right-click it, and choose Run As Server Control.

General Provides a repository for code snippets and control objects. Just drag and drop
them here, and pull them off when you need to use them later.

You can customize both the tabs and the items in each tab. To modify the tab groups, right-click
a tab heading, and select Rename Tab, Add Tab, or Delete Tab. To add an item, right-click the blank
space on the Toolbox, and Select Items. You can also drag items from one tab group to another.

Error List and Task List

The Error List and Task List are two versions of the same window. The Error List catalogs error infor-
mation that’s generated by Visual Studio when it detects problematic code. The Task List shows
a similar view with to-do tasks and other code annotations you're tracking. Each entry in the Error
List and Task List consists of a text description and, optionally, a link that leads you to a specific line
of code somewhere in your project.

With the default Visual Studio settings, the Error List appears automatically whenever you
build a project that has errors (see Figure 2-9).

@ 3Errors M\ 2 warnings | | (i) 0 Messages

Filg: Line Column F| 4

9 ol
V

@ 4 Identifier expected, int'is a keyword Defaulk. aspx.cs 15

4
AT
@ 5 Identifier expected Defaulk. aspx.cs 15 13 (a5}

AT mm

Figure 2-9. Viewing build errors in a project



CHAPTER 2 © VISUAL STUDIO 2005

To see the Task List, choose View » Other Windows » Task List. Two types of tasks exist—user
tasks and comments. You can choose which you want to see from the drop-down list at the top of the
Task List. User tasks are entries you've specifically added to the task list. You create these by clicking
the Create User Task icon (which looks like a clipboard with a check mark) in the Task List. You can
give your task a basic description, a priority, and a check mark to indicate when it's complete.

Note As with breakpoints, any custom tasks you add by hand are stored in the hidden solution files. This
makes them fairly fragile—if you rename or move your project, these tasks will disappear without warning (or
without even a notification the next time you open the website).

The comment entries are more interesting, because they’re added automatically and they link
to a specific line in your code. To try the comment feature, move somewhere in your code, and enter
the comment marker (') followed by the word TODO (which is commonly referred to as a token tag).
Now type in some descriptive text:

' TODO: Replace this hard-coded value with a configuration file setting.
Dim fileName As String = "c:\myfile.txt"

Because your comment uses the recognized token tag TODO, Visual Studio recognizes it and
automatically adds it to the Task List (as shown in Figure 2-10).

Comments <

! Description File: Line
T'I'[:u:::-: Replace this hard-coded value with a configuration File setting.,

Figure 2-10. Keeping track of tasks

To move to the line of code, double-click the new task entry. Notice that if you remove the com-
ment, the task entry is automatically removed as well.

Three token tags are built-in—HACK, TODO, and UNDONE. However, you can add more. Simply
select Tools » Options. In the Options dialog box, navigate to the Environment » Task List tab. You'll
see a list of comment tokens, which you can modify, remove, and add to. Figure 2-11 shows this
window with a new ASP comment token that you could use to keep track of sections of code that have
been migrated from classic ASP pages.
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Figure 2-11. Adding a new comment token

Server Explorer

The Server Explorer provides a tree that allows you to explore various types of services on the current
computer (and other servers on the network). It’s similar to the Computer Management administra-
tive tool. Typically, you'll use the Server Explorer to learn about available event logs, message queues,
performance counters, system services, and SQL Server databases on your computer.

The Server Explorer is particularly noteworthy because it doesn't just provide a way for you to
browse server resources; it also allows you to interact with them. For example, you can create data-
bases, execute queries, and write stored procedures using the Server Explorer in much the same
way that you would using the Enterprise Manager administrative utility that’s included with
SQL Server 2000 or SQL Server Management Studio in SQL Server 2005. To find out what you can do
with a given item, right-click it. Figure 2-12 shows the Server Explorer window listing the databases
in a local SQL Server and allowing you to retrieve all the records in the selected table.
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Figure 2-12. Querying data in a database table

The Code Editor

Many of Visual Studio’s most welcome enhancements appear when you start to write the code that
supports your user interface. To start coding, you need to switch to the code-behind view. To switch
back and forth, you can use two buttons that are placed just above the Solution Explorer window.
The tooltips identify these buttons as View Code and View Designer. When you switch to code view,
you'll see the page class for your web page. You'll learn more about code-behind later in this chapter.

ASPNET is event-driven, and everything in your web-page code takes place in response to an
event. To create a simple event handler for the Button.Click event, double-click the button in design
view. Here’s a simple example that displays the current date and time in a label:

Protected Sub Buttoni Click
(Byval sender As Object, ByVal e As System.EventArgs)
Handles Buttoni1.Click
Label1.Text = "Current time: " &
DateTime.Now.ToLongTimeString()
End Sub

To test this page, select Debug » Start Debugging from the menu. Because this is the first time
running any page in this application, Visual Studio will inform you that you need a configuration
file that specifically enables debugging (see Figure 2-13).
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Debugging Not Enabled E| le

The page cannot be run in debug mode because debugging is not enabled in the Web, config file.
‘what would you like to do?

_{5 Debugging should be disabled in the Web. config file before deployving the
‘Web site to a production environment,

(O Run without debugging. (Equivalent ko Chrl+F5)

Ok Cancel

Figure 2-13. Adding a web.config file automatically

Click OK to add this configuration file. Then, Visual Studio will launch your default browser,
with the URL set to your page. At this point, your request will be passed to ASPNET, which will com-
pile the page and execute it.

To test your event-handling logic, click the button on the page. The page will then be submitted
to ASPNET, which will run your event-handling code and return a new HTML page with the data (as
shown in Figure 2-14).

3 WebForm1 - Microsoft Internet Explorer, [ZI[EI[‘S_?I
File  Edit Miew Favorites Tools  Help -'\) Back - i :f
Address @I] http: fflocalhost fwebapplication3webForm]l . aspx i

Current time: 2:10:55 P

&] Dare & Local intranet

Figure 2-14. Testing a simple web page

Adding Assembly References

By default, ASPNET makes a small set of commonly used .NET assemblies available to all web
pages. These assemblies (listed in Table 2-4) are configured through a special machine-wide config-
uration file. You don’t need to take any extra steps to use the classes in these assemblies.

Table 2-4. Core Assemblies for ASPNET Pages

Assembly Description

mscorlib.dll and System.dll Includes the core set of .NET data types, common exception
types, and numerous other fundamental building blocks.

System.Configuration.dll Includes classes for reading and writing configuration informa-
tion in the web.config file, including your custom settings.

System.Data.dll Includes the data container classes for ADO.NET.

System.Drawing.dll Includes classes representing colors, fonts, and shapes. Also includes

the GDI+ drawing logic you need to build graphics on the fly.
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Assembly

Description

System.Web.dll
System.Web.Services.dll
System.Xml.dll

System.EnterpriseServices.dll
System.Web.Mobile.dll

Includes the core ASPNET classes, including classes for building
web forms, managing state, handling security, and much more.

Includes classes for building web services—units of code that can
be remotely invoked over HTTP.

Includes .NET classes for reading, writing, searching, transforming,
and validating XML.

Includes .NET classes for COM+ services such as transactions.

Includes .NET classes for the mobile web controls, which are
targeted for small devices such as web-enabled cell phones.

If you want to use additional features or a third-party component, you may need to import
more assemblies. For example, if you want to use an Oracle database, you need to add a reference to
the System.Data.OracleClient.dll assembly. To add a reference, right-click the project in the Solution
Explorer, and select Add Reference from the context menu. The Add Reference dialog box will appear,
with a list of registered .NET assemblies (see Figure 2-15).

Add Reference
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m, 1t
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sysglobl 2.0.0.0 v2,0,50215  CAWINDOWS\Microsof
Syskem 2.0.0.0 v2,0,50215  CAWINDOWS\Microsof,
Syskem, Configuration 2.0.0.0 v2,0,50215  CAWINDOWS\Microsof
Syskem,Configuration.I...  2.0.0.0 v2,0,50215  CAWINDOWS\Microsof

L 1IN i

Syskem,Data, Sqlxml 2.0.0.0 v2.0,50215

System,Deployment 2.0.0.0 v2,0,50215  CAWINDOWS\Microsof,
System,Design 2.0.0.0 v2,0,50215  CAWINDOWS\Microsof,
Syskem,DirectoryServices  2,0.0.0 v2,0,50215  CAWINDOWS\Microsof
Syskem,DirectoryServic,,.  2.0.0.0 v2,0,50215  CAWINDOWS \Microsof
Syskem,Drawing 2.0.0.0 v2,0,50215  CAWINDOWS\Microsof,
Swatem. Drawinn. Nesinn 2.0.n.n W2 MLENP1S O WINDOWSIMicrnsnf, Y
£ >
Ok ] [ Cancel

RIX]

f,

CAWINDOWS Microsaf,

Figure 2-15. Adding a reference

In the Add Reference dialog box, select the component you want to use. If you want to use
a component that isn't listed here, you'll need to click the Browse tab and select the DLL file from

the appropriate directory.

When you add a reference, Visual Studio modifies the web.config file to indicate that you
use this assembly. Here’s an example of what you might see after you add a reference to the

System.Data.OracleClient file:
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<?xml version="1.0"?>
<configuration xmlns="http://schemas.microsoft.com/.NetConfiguration/v2.0">
<system.web>
<compilation debug="true">
<assemblies>
<add assembly="System.Data.OracleClient, Version=2.0.0.0, ..."/>
</assemblies>
</compilation>
<!-- Other settings omitted. -->
</system.web>
</configuration>

Chapter 5 explores the web.config file in greater detail.

If you add a reference to an assembly that isn't stored in the GAC (global assembly cache) on
the development machine, Visual Studio will create a Bin subdirectory in your web application and
copy the DLL into that directory. This step isn’t required for assemblies in the GAC because they are
shared with all the .NET applications on the computer.

Note Unlike previous versions of Visual Studio, in Visual Studio 2005 you won’t see a list of assembly refer-
ences in the Solution Explorer. Instead, you need to crack open the web.config file to get that information.

Adding a reference isn't the same as importing the namespace with the Imports statement. The
Imports statement allows you to use the classes in a namespace without typing the long, fully quali-
fied class names. However, if you're missing a reference, it doesn't matter what Using statements you
include—the classes won't be available. For example, if you import the System.Web.UI namespace,
you can write Page instead of System.Web.UI.Page in your code. But if you haven't added a reference
to the System.Web.dll assembly that contains these classes, you still won't be able to access the classes
in the System.Web.UI namespace.

IntelliSense and Outlining

As you program with Visual Studio, you'll become familiar with its many timesaving conveniences.
The following sections outline the most important features you'll use (none of which is new in
Visual Studio 2005).

Tip Visual Studio does include one new IntelliSense feature—XHTML (Extensible HTML) validation. You'll learn
about this feature, and how to control the level of XHTML support you want, in Chapter 3.

Outlining

Outlining allows Visual Studio to “collapse” a subroutine, block structure, or region to a single line. It
allows you to see the code that interests you, while hiding unimportant code. To collapse a portion
of code, click the minus box next to the first line. Click the box again (which will now have a plus
symbol) to expand it (see Figure 2-16).
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Figure 2-16. Collapsing code

Member List

Visual Studio makes it easy for you to interact with controls and classes. When you type a class or
object name, Visual Studio pops up a list of available properties and methods (see Figure 2-17). It
uses a similar trick to provide a list of data types when you define a variable and to provide a list of
valid values when you assign a value to an enumeration.
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Figure 2-17. IntelliSense at work



46

CHAPTER 2 ' VISUAL STUDIO 2005

Visual Studio also provides a list of parameters and their data types when you call a method or
invoke a constructor. This information is presented in a tooltip above the code and is shown as you
type. Because the .NET class library heavily uses function overloading, these methods may have
multiple different versions. When they do, Visual Studio indicates the number of versions and allows
you to see the method definitions for each one by clicking the small up and down arrows in the tooltip.
Each time you click the arrow, the tooltip displays a different version of the overloaded method (see
Figure 2-18).

Default.aspx.wb* | Default.aspx* | Start Page -
# (Page Events) [ﬁ # Load

Imports System

Imports System.Data

Imports System.Configuration

Inports System.Web
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Imports System.Web.UI.WebControls

Imports System.Web.UI.WebControls.WebParts

Imports System.Web.UI_HtmlControls

=]l ]x

[FlPartial Class Default

Inherits System.Web.UI.Page

=l Protected Sub Page Load(Byval sender As CObject, Byval e Az System.EventArgs) Handles Me.Load
Page.Validate( T

End [s1cof2s validate () | b
Instructs any validation controls included on the page to validate their assigned \nformauom‘\

|Pr1vate Sub MyMethod ‘
End Class

[l B

Figure 2-18. IntelliSense with overloaded methods

Error Underlining

One of the code editor’s most useful features is error underlining. Visual Studio is able to detect

a variety of error conditions, such as undefined variables, properties, or methods; invalid data type
conversions; and missing code elements. Rather than stopping you to alert you that a problem
exists, the Visual Studio editor quietly underlines the offending code. You can hover your mouse
over an underlined error to see a brief tooltip description of the problem (see Figure 2-19).
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Figure 2-19. Highlighting errors at design time

Visual Studio won't flag your errors immediately. Instead, it will quickly scan through your code
as soon as you try to compile it and mark all the errors it finds. If your code contains at least one error,
Visual Studio will ask you whether it should continue. At this point, you’ll almost always decide to
cancel the operation and fix the problems Visual Studio has reported. (If you choose to continue, you'll
actually wind up using the last compiled version of your application, because the NET compilers
can’t build an application that has errors.)

Note You may find that as you fix errors and rebuild your project you discover more problems. That’s because
Visual Studio doesn’t check for all types of errors at once. When you try to compile your application, Visual Studio
scans for basic problems such as unrecognized class names. If these problems exist, they can easily mask other
errors. On the other hand, if your code passes this basic level of inspection, Visual Studio checks for more subtle
problems such as trying to use an unassigned variable.

The Coding Model

So far, you've learned how to design simple web pages, and you've taken a tour of the Visual Studio
interface. But before you get to serious coding, it's important to understand a little more about the
underpinnings of the ASPNET code model. In this section, you'll learn about your options for using
code to program a web page and how ASPNET events wire up to your code.

Visual Studio supports two models for coding web pages and web services:
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Inline code: This model is the closest to traditional ASP. All the code and HTML is stored in

a single .aspx file. The code is embedded in one or more script blocks. However, even though
the code is in a script block, it doesn’t lose IntelliSense or debugging support, and it doesn’t
need to be executed linearly (like classic ASP code). Instead, you'll still react to control events
and use subroutines. This model is handy because it keeps everything in one neat package, and
it's popular for coding simple web pages.

Code-behind: This model separates each ASPNET web page into two files: an .aspx markup file
with the HTML and control tags, and a .vb code file with the source code for the page. This
model provides better organization, and separating the user interface from programmatic logic
is keenly important when building complex pages. In Visual Studio 2005, the implementation

of the code-behind model has changed, but the overall philosophy is the same.

In.NET 1.0 and 1.1, the design tool you choose determines the model you use. With Visual Studio,
you have the freedom to use either approach. When you add a new web page to your website (using
Website » Add New Item), the Place Code in a Separate File check box chooses whether you want to
use the code-behind model (see Figure 2-20). Visual Studio remembers your previous setting for the
next time you add a new page, but it’s completely valid (albeit potentially confusing) to mix both
styles of pages in the same application.

Templates: |E‘
visual Studio installed templates ~
5El [wiieh Form [master Pags 8:|web User Contral
Iﬂ HTML Page ﬂ\f\ieb Service ‘Hc\ass
@_:]Sty\e Sheet a]GIDha\ Application Class lg_r,"'WEh Configuration File
[ @ *ML Schema |S] TextFile
;Resuurce File U SOL Database Iél DataSet
g Gereric Handler @]5@ Map @thbMe ‘Web Form =
%]VBScr\pt File @ Report :gjcrystal Report
%‘IJSEript File H;*Mnhwle WWeb User Control I;_i‘MDbHE! Web Configuration File
I_Li"_[lXSLT File | Sy skin File @JBrowser File
&) Class Diagram
My Templates |
_5j'§|Search Online Templates.,. M

| A form for Web Applications ‘

MName: ‘ Default2.aspx

Language: ‘Vlsua\ Basic M F'|SEE‘ code in separate file

[C]select master page

Figure 2-20. Choosing the coding model

To understand the difference, it helps to consider a simple page, like the following dynamic
time example; this is TestFormInline.aspx, which shows how the page looks with inline code:

<%@ Page Language="vb" %>
<script runat="server">
Protected Sub Buttoni Click

(ByVal sender As Object, ByVal e As System.EventArgs)
Labell.Text = "Current time: " & DateTime.Now.ToLongTimeString()

End Sub
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</script>

<html xmlns="http://www.w3.0rg/1999/xhtml" >
<head runat="server">
<title>Test Page</title>
</head>
<body>
<form id="form1" runat="server">
<div>
<asp:Label ID="Label1" runat="server" Text="Click Me!">
</asp:Label>
<br />
<br />
<br />
<asp:Button ID="Button1" runat="server"
OnClick="Button1_Click" Text="Button" />
</div>
</form>
</body>
</html>

The following listings, TestFormCodeBehind.aspx and TestFormCodeBehind.aspx.vb,
show how the page is broken up into two pieces using the code-behind model. This is
TestFormCodeBehind.aspx:

<%@ Page Language="vb" AutoEventWireup="true" CodeFile="TestFormCodeBehind.aspx.vb"
Inherits="TestFormCodeBehind"%>.aspx:

<html xmlns="http://www.w3.0rg/1999/xhtml" >
<head runat="server">
<title>Test Page</title>
</head>
<body>
<form id="form1" runat="server">
<div>
<asp:Label ID="Label1" runat="server" Text="Click Me!"></asp:Label><br />
<br />
<br />
<asp:Button ID="Button1" runat="server" OnClick="Buttoni_ Click"
Text="Button" /></div>
</form>
</body>
</html>

This is TestFormCodeBehind.aspx.vb:

Partial Class TestFormCodeBehind
Inherits System.Web.UI.Page
Protected Sub Buttoni Click
(Byval sender As Object, ByVal e As System.EventArgs)
Labeli.Text = "Current time: " & DateTime.Now.ToLongTimeString()
End Sub
End Class

The only real difference in this code is that the page class is no longer implicit—instead it is
declared to contain all the page methods.
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Overall, the code-behind model is preferred for complex pages. Although the inline code model
is slightly more compact for small pages, as your code and HTML grows it becomes much easier to
deal with both portions separately. The code-behind model is also conceptually cleaner, as it explicitly
indicates the class you've created and the namespaces you've imported. Finally, the code-behind
model introduces the possibility that a web designer may refine the markup in your pages without
touching your code. This book uses the code-behind model for all examples.

How Code-Behind Files Are Connected to Pages

Every .aspx page starts with a Page directive. This Page directive specifies the language for the page,
and it also tells ASPNET where to find the associated code (unless you're using inline code, in which
case the code is contained in the same file).

You can specify where to find the associated code in several ways. In previous versions of ASPNET,
it was common to use the Src attribute to point to the source code file or the Inherits attribute to
indicate a compiled class name. However, both of these options have their idiosyncrasies. For exam-
ple, with the Inherits attribute, you’re forced to always precompile your code, which is tedious (and
can cause problems in development teams, because the standard option is to compile every page
into a single DLL assembly). But the real problem is that both approaches force you to declare every
web control you want to use with a member variable. This adds a lot of boilerplate code.

In ASPNET 2.0, you can solve the problem using a new language feature called partial classes,
which let you split a single class into multiple source code files. Essentially, the model is the same as
before, but the control declarations are shuffled into a separate file. You, the developer, never need
to be distracted by this file—instead you can just access your web-page controls by name. Keen eyes
will have spotted the word partial in the class declaration for your web-page code:

Partial Class TestFormCodeBehind
Inherits System.Web.UI.Page

End Class
With this bit of infrastructure in place, the rest is easy. Your .aspx page links to the source code
file using the CodeFile attribute, as shown here:

<%@ Page Language="vb" AutoEventWireup="true" CodeFile="TestFormCodeBehind.aspx.vb"
Inherits="TestFormCodeBehind"%>

Notice that Visual Studio uses a slightly unusual naming syntax for the source code file. It has
the full name of the corresponding web page, complete with the .aspx extension, followed by the .vb
extension at the end. This is just a matter of convention, and it avoids a problem if you happen to
create two different code-behind file types (for example, a web page and a web service) with the
same name.

How Control Tags Are Connected to Page Variables

When you request your web page in a browser, ASPNET starts by finding the associated code file. Then,
it generates a variable declaration for each control that has a runat="server" attribute declaration.
For example, imagine you have a text box named txtInput:

<asp:TextBox ID="txtInput" runat="server"/»

ASPNET generates the following member variable declaration and merges it with your page
class using the magic of partial classes:

Protected System.Web.UI.TextBox txtInput;
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To make sure this system works, you must keep both the .aspx markup file (with the control
tags) and the .vb file (with the source code) synchronized. If you edit control names in one piece
using another tool (such as a text editor), you'll break the link, and your code won'’t compile.

Incidentally, you'll notice that control variables are always declared with the protected accessi-
bility keyword. That’s because of the way ASPNET uses inheritance in the web-page model. The
following three layers are at work:

e First, the Page class from the .NET class library defines the basic functionality that allows
a web page to host other controls, render itself to HTML, and provide access to the traditional
ASP objects such as Request, Response, and Session.

¢ Second, your code-behind class (for example, TestFormCodeBehind) inherits from the Page
class to acquire the basic set of ASPNET web-page functionality.

* Finally, the .aspx page (for example, HelloWorldPage.aspx) uses the code from the custom page
class you created. This allows it to combine the user interface with the code that supports it.

Protected variables act like private variables with a key difference—they are accessible to
derived classes. In other words, using protected variables in your code-behind class ensures that
the variables are accessible in the derived page class. This allows ASPNET to connect your control
variables to your control tags at runtime.

How Events Are Connected to Event Handlers

Most of the code in an ASPNET web page is placed inside event handlers that react to web control
events. Using Visual Studio, you can add an event handler to your code in three ways:

Type it in by hand: In this case, you add the method directly to the page class. You must specify
the appropriate parameters so that the signature of the event handler exactly matches the sig-
nature of the event you want to handle. You'll also need to edit the control tag so that it links
the control to the appropriate event handler. (Alternatively, you can use delegates to wire this
up programmatically.)

Double-click a control in design view: In this case, Visual Studio will create an event handler for that
control’s default event (and adjust the control tag accordingly). For example, if you double-click
the page, it will create a Page.Load event handler. If you double-click a Button control, Visual
Studio will create an event handler for the Click event.

Choose the event from the Properties window: Just select the control, and click the lightning bolt
in the Properties window. You'll see a list of all the events provided by that control. Double-click
in the box next to the event you want to handle, and Visual Studio will automatically generate
the event handler in your page class and adjust the control tag.

The second and third options are the most convenient. The third option is the most flexible,
because it allows you to select a method in the page class that you've already created. Just select the
event in the Properties window, and click the drop-down arrow at the right. You'll see a list that includes
all the methods in your class that match the signature this event requires. You can then choose a method
from the list to connect it. Figure 2-21 shows an example where the Button.Click event is connected
to the Button_Click() method in your page class. The only limitation of this technique is that it works
exclusively with web controls, not server-side HTML controls.
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Figure 2-21. Attaching an event handler

Visual Studio 2005 uses automatic event wire-up, as indicated in the Page directive. Automatic
event wire-up has two basic principles:

¢ All page event handlers are connected automatically based on the name of the event handler.
In other words, the Page_Load() method is automatically called when the page loads. Visual
Studio adds a comment to your page class to point out the commonly used event methods.

» All control event handlers are connected using attributes in the control tag. The attribute has
the same name as the event, prefixed by the word On.

For example, if you want to handle the Click event of the Button control, you simply need to set
the OnClick attribute in the control tag with the name of the event handler you want to use. Here’s
the change you need:

<asp:Button id="cmdOK" OnClick="cmdOK_Click" runat="server">

ASPNET controls always use this syntax. Remember, because ASPNET must connect the event
handlers, the derived page class must be able to access the code-behind class. This means your
event handlers must be declared with the protected or public keyword. (Protected is preferred,
because it prevents other classes from seeing this method.)

Visual Studio Debugging

Visual Studio has always provided robust tools for debugging your web applications. In Visual
Studio 2005, these tools remain essentially the same, with some minor enhancements that make it
easier to drill into live objects and collections at runtime.

To debug a specific web page in Visual Studio, select that web page in the Solution Explorer,
and click the Start Debugging button on the toolbar. (If you are currently editing the web page you
want to test, you don't need to select it at all—just click Start Debugging to launch it directly.)

What happens next depends on the location of your project. If your project is stored on a remote
web server or a local IIS virtual directory, Visual Studio simply launches your default browser and
directs you to the appropriate URL. If you've used a file system application, Visual Studio starts its
integrated web server on a dynamically selected port (which prevents it from conflicting with IIS, if
it’s installed). Then Visual Studio launches the default browser and passes it a URL that points to the
local web server. Either way, the real work—compiling the page and creating the page objects—is
passed along to the ASPNET worker process.
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Tip Visual Studio’s built-in web server allows you to retrieve a file listing. This means if you create a web appli-
cation named MyApp, you can make a request in the form of http://localhost:port/MyApp to see a list of
pages. Then, just click the page you want to test. This process assumes your web application doesn’t have
a Default.aspx page—if it does, any requests for the website root automatically return this page.

The separation between Visual Studio, the web server, and ASPNET allows for a few interesting
tricks. For example, while your browser window is open, you can still make changes to the code and
tags of your web pages. Once you've completed your changes, just save the page, and click the Refresh
button in your browser to rerequest it. Although you’ll always be forced to restart the entire page to
see the results of any changes you make, it’s still more convenient than rebuilding your whole project.

Fixing and restarting a web page is handy, but what about when you need to track down an elusive
error? In these cases, you need Visual Studio’s debugging smarts, which are described in the next few
sections.

Note When you use the test web server, it runs all code using your user account. This is different from the
much more limited behavior you'’ll see in lIS, which uses a less-privileged account to ensure security. It’s important
to understand the difference, because if your application accesses protected resources (such as the file system,
a database, the registry, or an event log), you'll need to make sure you explicitly allow the IIS user. For more infor-
mation about IIS and the hosting model, refer to Chapter 18.

Single-Step Debugging

Single-step debugging allows you to execute your code one line at a time. It’s incredibly easy to use.
Just follow these steps:

1. Find alocation in your code where you want to pause execution, and start single-stepping
(you can use any executable line of code but not a variable declaration, comment, or blank line).
Click in the margin next to the line code, and a red breakpoint will appear (see Figure 2-22).

Default.aspx.vb* | Default aspx® | Start Page R

X

##Button [][ # cick [

Imports System.Web . UI.WebControls . WebParts
Inports System.Web.UI.HtmlControls

EPartial Class _Default
Inherits System.Web.UI.Page

=] Protected Sub Page Load (ByVal sender As Chiect, Byval e A3 System.EventArgs) Handles Me.Load

= End Sub
=] Protected Sub Buttonl Clicki{ByVal sender As Object, ByVal e As System.EventArgs) Handles Buttonl
Dim val As Decimal
(* ] f (Decimal.TryPars €XtBoxl.Text, val)} = True Then|

val = val * 2
Labell.Text = val.ToString ()
End If

r End Sub
~End Class

ol Bl

Figure 2-22. Setting a breakpoint
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2. Now start your program as you would ordinarily. When the program reaches your breakpoint,
execution will pause, and you'll be switched back to the Visual Studio code window. The
breakpoint statement won't be executed.

3. At this point, you have several options. You can execute the current line by pressing F8 or
Shift+F8. The following line in your code will be highlighted with a yellow arrow, indicating
that this is the next line that will be executed. You can continue like this through your pro-
gram, running one line at a time by pressing F8 or Shift+F8 and following the code’s path of
execution. Or, you can exit break mode and resume running your code by pressing F5.

Note Instead of using shortcut keys such as F8, Shift+F8, and F5, you can use the buttons in the
Visual Studio Debug toolbar. Alternatively, you can right-click the code window and choose an option from
the context menu.

4. Whenever the code is in break mode, you can hover over variables to see their current con-
tents. This allows you to verify that variables contain the values you expect (see Figure 2-23).
If you hover over an object, you can drill down into all the individual properties by clicking
a small plus symbol to expand it (see Figure 2-24).
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‘ ##Button1 IL” # Click v
Tnports System.Data E

Imports System.Configuration

Imports System.Web

Imports System.Web.Security

Imports System.Web.UT
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Inherits System.Web.UIL.Page

= Protected Sub Page Load (Byval sender Rs oObject, ByVal e RAs System.EventArgs) Handles Me

- End Sub L

= Protected Sub Buttonl Click (Bwval sender Rs Cbject, ByVal e As System.EventArgs) Handle:
0 £ al.Tr .Tex val)) = True Then|
(=) Labell.Text = val.ToString ()

End If
I

- End Sub
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| i ™

Figure 2-23. Viewing variable contents in break mode
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Figure 2-24. Viewing object properties in break mode

Tip You can even modify the values in a variable or property directly—just click inside the tooltip, and
enter the new value. This allows you to simulate scenarios that are difficult or time-consuming to re-create
manually or to test specific error conditions.

5. You can also use any of the commands listed in Table 2-5 while in break mode. These com-
mands are available from the context menu by right-clicking the code window or by using
the associated hot key.

Table 2-5. Commands Available in Break Mode

Command (Hot Key) Description

Step Into (F8) Executes the currently highlighted line and then pauses. If the currently
highlighted line calls a procedure, execution will pause at the first
executable line inside the method or function (which is why this
feature is called stepping into).

Step Over (Shift+F8) The same as Step Into, except that it runs procedures as though they are
a single line. If you select the Step Over command while a procedure
call is highlighted, the entire procedure will be executed. Execution will
pause at the next executable statement in the current procedure.

(Continued)
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Table 2-5. Continued

Command (Hot Key)

Description

Step Out (Ctrl+Shift+F8)

Continue (F5)

Run to Cursor

Set Next Statement

Show Next Statement

Executes all the code in the current procedure and then pauses at the
statement that immediately follows the one that called this method or
function. In other words, this allows you to step “out” of the current
procedure in one large jump.

Resumes the program and continues to run it normally without pausing
until another breakpoint is reached.

Allows you to run all the code up to a specific line (where your cursor is
currently positioned). You can use this technique to skip a time-consuming
loop.

Allows you to change your program’s path of execution while debugging.
It causes your program to mark the current line (where your cursor is
positioned) as the current line for execution. When you resume execution,
this line will be executed, and the program will continue from that point.

Moves focus to the line of code that is marked for execution. This line is
marked by a yellow arrow. The Show Next Statement command is useful
if you lose your place while editing.

You can switch your program into break mode at any point by clicking the pause button in the
toolbar or by selecting Debug » Break All.

Advanced Breakpoints

Choose Debug » Windows » Breakpoints to see a window that lists all the breakpoints in your current
project. The Breakpoints window provides a hit count, showing you the number of times a break-
point has been encountered (see Figure 2-25). You can jump to the corresponding location in code
by double-clicking a breakpoint. You can also use the Breakpoints window to disable a breakpoint
without removing it. That allows you to keep a breakpoint to use in testing later, without leaving it
active. Breakpoints are automatically saved with the hidden solution file described earlier.

ﬁ Columns ~

Condition Hit Count

L:JBreakpoints EACal Stack |ElImmediate Window

Figure 2-25. The Breakpoints window
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Visual Studio allows you to customize breakpoints so they occur only if certain conditions are
true. To customize a breakpoint, right-click it, and select Breakpoint Properties. In the window that
appears, you can take one of the following actions:

¢ Click the Condition button to set an expression. You can choose to break when this expression
is true or when it has changed since the last time the breakpoint was hit.

* Click the Hit Count button to create a breakpoint that pauses only after a breakpoint has
been hit a certain number of times (for example, at least 20) or a specific multiple of times
(for example, every fifth time).

Variable Watches

In some cases, you might want to track the status of a variable without switching into break mode
repeatedly. In this case, it's more useful to use the Locals, Autos, and Watch windows, which allow
you track variables across an entire application. Table 2-6 describes these windows.

Table 2-6. Variable Tracking Windows

Window Description

Locals Automatically displays all the variables that are in scope in the current procedure.
This offers a quick summary of important variables.

Autos Automatically displays variables that Visual Studio determines are important for the
current code statement. For example, this might include variables that are accessed
or changed in the previous line.

Watch Displays variables you have added. Watches are saved with your project, so you can
continue tracking a variable later. To add a watch, right-click a variable in your code,
and select Add Watch; alternatively, double-click the last row in the Watch window,
and type in the variable name.

Each row in the Locals, Autos, and Watch windows provides information about the type or class
of the variable and its current value. If the variable holds an object instance, you can expand the
variable and see its private members and properties. For example, in the Locals window you’ll see
the Me variable, which is a reference to the current page class. If you click the plus symbol next to
this, a full list will appear that describes many page properties (and some system values), as shown
in Figure 2-26.
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Figure 2-26. Viewing the current page class in the Locals window

The Locals, Autos, and Watch windows allow you to change variables or properties while your
program is in break mode. Just double-click the current value in the Value column, and type in
anew value. If you are missing one of the watch windows, you can show it manually by selecting it
from the Debug » Windows submenu.

Visual Studio Macros

One of the most exciting frills of the Visual Studio development environment is its powerful macro
and add-in framework (which is largely unchanged from previous versions of Visual Studio .NET).
This framework, known as the Visual Studio Automation model, provides almost 200 objects that
give you unprecedented control over the IDE, including the ability to access and manipulate the
current project hierarchy, the collection of open windows, and the integrated debugger. One of the
most convenient and flexible Automation tools is the macro facility.

The simplest macro is a keystroke recording. To create a simple keystroke macro, select Tools »
Macros » Record Temporary Macro from the Visual Studio menu, and press the appropriate keystrokes.
Once you're finished, click the stop button on the floating macro toolbar. You can now replay the
recorded macro (with the Ctrl+Shift+P shortcut key).

Note Visual Studio allows only one recorded macro, which is overwritten every time you record a new one. To
make a temporary macro permanent, you’ll need to cut and paste the code into a different subroutine.
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A good way to start learning about macros is to use the record facility and then look at the code
it generates. Select Tool » Macros » Macro Explorer to see a window that shows a tree of macro
modules and the macros they contain (see Figure 2-27). Each macro corresponds to a Visual Basic
subroutine. (Unfortunately, C# is not supported.) To edit the macro you just created, right-click the
TemporaryMacro subroutine in the RecordingModule, and select Edit.

Macro Explorer 3]

= Macros
= (=] MyMacros
5] Modulet
= i8] RecordingMaduls
i) Tempe | SCHD
- _g Samples

5] AddDirAsSinFolder
5] DevStudiosEditar
5] Makefddin

55 Utilicies

5] wsDebugger

51 wSEditor

[Ea RS e T )

Figure 2-27. The Macro Explorer

Macro code uses a special DTE (design-time environment) object model. The DTE hierarchy
provides the core features that allow you to interact with every aspect of the IDE. Some of the ingre-
dients at your fingertips include the following:

* Window objects (used to close, rearrange, or otherwise manipulate open windows)

* Document objects (used to edit text)

* Solution and project objects (used to manage the underlying files and project collection)
* Tool-window objects (used to configure the IDE’s interface)

* Debugging objects (used for tasks such as creating breakpoints and halting execution)

» Event objects (used to react to IDE events)

¢ Code-manipulation objects (used to analyze your project’s code constructs)

For example, the following macro automatically lists all the files in the project that have been
modified but not saved. The list is shown in the Output window.

Sub ListModifiedDocuments()
Dim win As Window = DTE.Windows.Item(Constants.vsWindowKindCommandWindow)
Dim target As Object
" If the current window is an Output window, use it. Otherwise, use a
' helper function to find and activate the window.
If (DTE.ActiveWindow Is win) Then
target = win.Object
Else
' The GetOutputWindowPane is a helper function that can be downloaded
' from MSDN or Apress with the code download accompanying this book
target = GetOutputWindowPane("Modified Documents™)
target.clear()
End If

' Loop through all the open documents, and if unsaved changes are detected,
' write the document name to the Output window.
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Dim doc As Document
For Each doc In DTE.Documents
If Not doc.Saved Then
target.OutputString(doc.Name & " " & doc.FullName & _
Microsoft.VisualBasic.Constants.vbCrLf)
End If
Next
End Sub

Figure 2-28 shows the result of running this macro.

Dutput @
Show output from: - Modified Documents =& | & B | = |5

TastPage_aspx.cs  E:\Temp)SampleSite)TestPage.aspx.es
HewPage.aspx  E:iTempiSanpleSitei\NewPage.aspx

Figure 2-28. Detecting changed documents

You can run the Macro from the Tools » Macro menu in Visual Studio 2005.

This is only one of several dozen useful macros that are included in the Samples macro project,
which comes with Visual Studio 2005 (and the code download for this chapter). To learn more about
Visual Studio macros and add-ins, you can consult a dedicated book on the subject. Several good
titles exist for the previous version of Visual Studio .NET, including Inside Microsoft Visual Studio
.NET (Microsoft Press, 2003).

Tip Many useful Visual Studio macros are installed by default with Visual Studio 2005. Look under the Samples
group in the Macro Explorer, which has macros for adding comments, switching on and off line numbers, inserting
dates and times, formatting code, and debugging. You can also download more advanced add-ins from http://
msdn.microsoft.com/vstudio/downloads/samples. These samples can do everything from automating the
build process and integrating with Outlook to spell-checking the text in your user interface.

ASP.NET Development Helper

Another interesting tool that’s only begun its development is the ASPNET Development Helper, a free
tool created by Nikhil Kothari from the ASPNET team. The central goal of the ASPNET Development
Helper is to improve the debugging experience for ASPNET developers by enhancing the ability of
the browser to participate in the debugging process. Currently, the ASPNET Development Helper is
limited to just a few useful features:

» It can report whether a page is in debug or tracing mode.
e It can display the view state information for a page.

* It can display the trace information for a page (and hide it from the page, making sure your
layout isn't cluttered).

e Tt can clear the cache or trigger an application restart.
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Many of these features haven't been covered yet, but you'll see a brief example of the ASPNET
Development Helper in the next chapter.

The design of the ASPNET Development Helper is quite interesting. Essentially, it’s built out of
two pieces:

e An HTTP module that runs on the web server and makes additional information available to
the client browser. (You'll learn about HTTP modules in Chapter 5.)

¢ An unmanaged browser plug-in that communicates with the HTTP module and displays the
important information in a side panel in the browser (see Figure 2-29). The browser plug-in
is designed exclusively for Internet Explorer, but at least one other developer has already cre-
ated a Firefox version that works with the same HTTP module.

Open the browser

The ASP.NET plug-in for the

Development ASP.NET

Helper Panel Development
Helper
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M, The current page has debugaing Hello World!

turned on.
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directive or in configuration,

Tools
€, Browser Actions
Show iew State. .
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Figure 2-29. The ASENET Development Helper

To download the ASPNET Development Helper, surf to http://www.nikhilk.net/
ASPNETDevHelperTool.aspx. There you can download two DLLs, one for the HTTP module
(WebDevInfo.dll) and one for the browser plug-in (WebDevInfo.BHO.dll). Copy these to any directory.

Next, you install the HTTP module with the following command:

Gacutil /I nStuff.WebDevInfo.dll
Then you need to add this module to the list of httpModules in your configuration. Open web.config

(it should be in %windir%\Microsoft. NET\Framework\v2.0.50215\config or similar), and add the
following entry to the <httpModules> section:

<add name="DevInfo" type="nStuff.WebDevInfo.DevInfoModule, nStuff.WebDevInfo,
version=0.5.0.0, Culture=neutral, PublicKeyToken=8fcoe3af5abc6c4" />

61



62

CHAPTER 2 ' VISUAL STUDIO 2005

Finally, install the browser extension with the following command line:
regsvr32 nStuff.WebDevInfo.BHO.d1l

Next, you need install the assembly for the HTTP module into the GAC. You can do this by
dragging and dropping in Windows Explorer, but it’s generally easier to use the gacutil.exe utility.
Start a Visual Studio command prompt (choose Programs » Visual Studio 2005 » Visual Studio
Tools » Visual Studio 2005 Command Prompt from the Start menu), and then run this command:

gacutil /i nStuff.WebDevInfo.dll

Now, when you want to use this tool with a web application, you need to modify the web.config
file so it loads the HTTP module. The content you need depends on the exact version of the tool
you're using, but it looks something like this:

<configuration xmlns="http://schemas.microsoft.com/.NetConfiguration/v2.0">
<system.web>
<httpModules>
<add name="DevInfo" type="nStuff.WebDevInfo.DevInfoModule, nStuff.WebDevInfo,
Version=0.5.0.0, Culture=neutral, PublicKeyToken=8fcOe3af5abcb6c4" />
</httpModules>

</system.web>
</configuration>

Now, run one of the pages from this application. To actually call up the browser plug-in, look
for a button (with a gear icon) in the browser, which will have been added to the end of the Standard
toolbar. When you click this icon, you'll see a display like the one shown in Figure 2-29 (assuming
you're currently viewing an ASPNET page from an application that has the matching HTTP module
loaded).

You'll see the ASPNET Developer Helper at work in Chapter 3 and Chapter 6.

Summary

This chapter considered the role that Visual Studio can play in helping you develop your web appli-
cations. At the same time that you explored its rich design-time environment, you also learned
about how it works behind the scenes with the code-behind model and how to extend it with time-
saving features such as macros. In the next two chapters, you'll jump into full-fledged ASPNET
coding by examining web pages and server controls.



CHAPTER 3

Web Forms

ASP.NET pages (officially known as web forms) are a vital part of an ASPNET application. They
provide the actual output of a web application—the web pages that clients request and view in their
browsers.

Although web pages aren’t anything new, the concept of web forms is something entirely unique
to ASPNET. Essentially, web forms allow you to create a web application using the same control-based
interface as a Windows application. To run an ASPNET web form, the ASPNET ISAPI extension reads
the entire file, generates the corresponding objects, and fires a series of events. You react to these events
using thoroughly object-oriented code.

This chapter provides in-depth coverage of web forms. You'll learn how they work and how you
can use them to build simple pages. You'll also get an in-depth first look at the page-processing life
cycle and the ASPNET server-side control model.

WEB FORMS CHANGES IN .NET 2.0

The web forms model undergoes a minor tune-up in ASPNET 2.0—there aren’t many dramatic differences. Some
of the changes take place behind the scenes—for example, pages now include even more events in their life cycle
so they can plug into other ASP.NET features, such as themes and the new data binding model.

This chapter concentrates mostly on the core web forms model that was established in ASP.NET 1.0. However,
you'll find a few refinements in this chapter. Here they are, in order of their appearance:

o liew state chunking: Instead of placing all your view state information into a single field, you can tell ASP.NET
to split it into several fields of a certain size. This feature is primarily intended to resolve issues with proxy
servers that don’t support really large hidden input fields.

e  XHTML support. Web forms now render themselves using XHTML-compliant markup. This is a major shift
from ASP.NET 1.x, and it’s almost entirely painless.

* Programmable page header. The <head> portion of a web page is now exposed as an instance of the
HtmlIHead server control. Using this control, you can programmatically change the title, add metadata, or add
linked stylesheets to the page.

If you're a seasoned ASP.NET 1.x developer, you can hone in on these additions as you work your way through
this chapter.
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Page Processing

One of the key goals of ASPNET is to create a model that lets web developers rapidly develop web
forms in the same way that Windows developers can build made-to-measure windows in a desktop
application. Of course, web applications are very different from traditional rich client applications.
There are two key stumbling blocks:

Web applications execute on the server: For example, suppose you create a form that allows the
user to select a product record and update its information. The user performs these tasks in the
browser, but in order for you to perform the required operations (such as updating the data-
base), your code needs to run on the web server. ASPNET handles this divide with a technique
called postback, which sends the page (and all user-supplied information) to the server when
certain actions are performed. Once ASPNET receives the page, it can then fire the correspon-
ding server-side events to notify your code.

Web applications are stateless: In other words, before the rendered HTML page is sent to the
user, your web-page objects are destroyed and all client-specific information is discarded. This
model lends itself well to highly scalable, heavily trafficked applications, but it makes it difficult
to create a seamless user experience. ASPNET includes several tools to help you bridge this
gap; most notable is a persistence mechanism called view state, which automatically embeds
information about the page in a hidden field in the rendered HTML.

In the following sections, you'll learn about both the postback and the view state features.
Together, these mechanisms help abstract the underlying HTML and HTTP details, allowing devel-
opers to work in terms of objects and events.

HTML Forms

If you're familiar with HTML, you know that the simplest way to send client-side data to the server is
using a <form> tag. Inside the <form> tag, you can place other <input> tags to represent basic (UI)
user interface ingredients such as buttons, text boxes, list boxes, check boxes, and radio buttons.

For example, here’s a form tag with a submit button, two check boxes, a text box, and a button,
for a total of five <input> tags:

<html>
<head>
<title>Programmer Questionnaire</title>
</head>
<body>
<form method="post" action="page.aspx">
<p>Enter your first name:&nbsp;
<input type="text" name="FirstName"/><br>
Enter your last name:&nbsp;
<input type="text" name="LastName"/><p>
<p>You program with:<br>
&nbsp;&nbsp;&nbsp;
<input type="checkbox" name="VB"/>VB.NET<br>
&nbsp;&nbsp;&nbsp;
<input type="checkbox" name="CS"/>Ci<br><br>
<input type="submit" value="Submit" id="0K"/>
</p>
</form>
</body>
</html>

Figure 3-1 shows what this basic page looks like in a web browser.
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G | Programmer Questionnaire - Microsoft Internet Explorer

File Edit Wiew Favorites Tools  Help J > Iﬂ 8

Address @j http: fflocalhost/ Testweb/page, aspx b

Enter your first name: | Matthew

Enter your last name: | MacDanald
Tou program with:
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VB NET

@I] Done j My Computer

Figure 3-1. A simple HTML form

When the user clicks the submit button, the browser collects the current value of each control
and pastes it together in a long string. This string is then sent back to the page indicated in the <form>
tag (in this case, page.aspx) using an HTTP POST operation.

In this example, that means the web server might receive a request with this string of
information:

FirstName=Matthew&LastName=MacDonald&CS=0on&VB=0on

The browser follows certain rules when constructing this string. Information is always sent as
a series of name/value pairs separated by the ampersand (&) character. Each name/value pair is
split with an equal (=) sign. Check boxes are left out unless they are checked, in which case the browser
supplies the text on for the value. For the complete lowdown on the HTML forms standard, which is
supported in every current browser, surf to http://www.w3.org/TR/REC-html40/interact/forms.html.

Virtually all server-side programming frameworks add a layer of abstraction over the raw form
data. They parse this string and expose it in a more useful way. For example, JSP, ASP, and ASPNET all
allow you to retrieve the value of a form control using a thin object layer. In ASP and ASPNET, you
can look up values by name in the Request.Form collection. Here’s an example in ASPNET:

Dim firstName As String = Request.Form("FirstName")

This thin veneer over the actual POST message is helpful, but it’s still a long way from a true
object-oriented framework. That’s why ASPNET goes another step further. When a page is posted
back to ASPNET, it extracts the values, populates the Form collection (for backward compatibility
with ASP code), and then configures the corresponding control objects. This means you can use the
following much more intuitive syntax to retrieve information:

Dim firstName As String = txtFirstName.Text

This code also has the benefit of being type-safe. In other words, if you're retrieving the state of
the check box, you'll receive a Boolean True or False value, instead of a string with the word on. In
this way, developers are insulated from the quirks of HTML syntax.

Note In ASPNET, all controls are placed inside a single <form> tag. This tag is marked with the runat="server"
attribute, which allows it to work on the server side. ASP.NET does not allow you to create web forms that contain
more than one server-side <form> tag, although it is possible to create a page that posts to another page using
a technique called cross-page posting, which is discussed in Chapter 6.
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Dynamic Interfaces

Clearly, the control model makes life easier for retrieving form information. What’s even more
remarkable is how it simplifies your life when you need to add information to a page. Almost all web
control properties are readable and writable. This means you can set the Text property of a text box
just as easily as you can read it.

For example, consider what happens if you want to update a piece of text on a web page to
reflect some information the user has entered earlier. In classic ASP, you would need to find a con-
venient place to insert a script block that would write the raw HTML. Here’s an example that displays
a brightly colored welcome message:

Dim message As String = "<span style=""color:Red"">Welcome
& FirstName & " " & LastName & "</span>"
Response.Write(message)

On the other hand, life is much neater when you define a Label control in ASPNET:

<asp:Label id="1blWelcome" runat="server" />

Now you can simply set its properties:

1blWelcome.Text = "Welcome " & FirstName & " " & LastName
1blWelcome.ForeColor = Color.Red

This code has several key advantages. First, it’s much easier to write (and to write without
errors). The savings seems fairly minor in this example, but it is much more dramatic when you
consider a complete ASPNET page that needs to dynamically render complex blocks of HTML that
contain links, images, and styles.

Second, control-based code is also much easier to place inside a page. You can write your ASPNET
code wherever the corresponding action takes place. On the other hand, in classic ASP you need to
worry about where the content appears on the page and arrange your script blocks code appropri-
ately. If a page has several dynamic regions, it can quickly become a tangled mess of script blocks
that don’t show any clear relation or organization.

Another, subtler but equally dramatic, advantage of the control model is the way it hides the
low-level HTML details. Not only does this allow you to write code without learning all the idiosyn-
crasies of HTML, but it also allows your pages to support a wider range of browsers. Because the
control renders itself, it has the ability to tailor its output to support different browsers, enhanced
client-side features, or even other HTML-related standards such as XHTML or WML (which is used
in mobile browsers). Essentially, your code is no longer tightly coupled to the HTML standard.

The ASP.NET Event Model

Classic ASP uses a linear processing model. That means code on the page is processed from start to
finish and is executed in order. Because of this model, classic ASP developers need to write a consider-
able amount of code even for simple pages. A classic example is a web page that has three different
submit buttons for three different operations. In this case, your script code has to carefully distinguish
which button was clicked when the page is submitted and then execute the right action using
conditional logic.

ASPNET provides a refreshing change with its new event-driven model. In this model, you add
controls to a web form and then decide what events you want to respond to. Each event handler is
wrapped up in a discrete method, which keeps the page code tidy and organized. This model is nothing
new, but until the advent of ASPNET it has been the exclusive domain of windowed UI programming
in rich client applications.

So, how do ASPNET events work? It’s actually surprisingly straightforward. Here’s a brief outline:
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1. Your page runs for the first time. ASPNET creates page and control objects, the initialization
code executes, and then the page is rendered to HTML and returned to the client. The page
objects are also released from server memory.

2. At some point, the user does something that triggers a postback, such as clicking a button.
At this point, the page is submitted with all the form data by using ViewState information.

3. ASPNET intercepts the returned page and re-creates the page objects, taking care to return
them to the state they were in the last time the page was sent to the client.

4. Next ASPNET checks what operation triggered the postback, and it raises the appropriate
events (such as Button.Click), which your code can react to. Typically, at this point you'll
perform some server-side operation (such as updating a database or reading data from
a file) and then modify the control objects to display new information.

5. The modified page is rendered to HTML and returned to the client. The page objects are
released from memory. If another postback occurs, ASPNET repeats the process in
steps 2 through 4.

In other words, ASPNET doesn't just use the form data to configure the control objects for your
page. It also uses it to decide what events to fire. For example, if it notices the text in a text box has
changed since the last postback, it raises an event to notify your page. It’s up to you whether you
want to respond to this event.

Note Keep in mind that since HTML is completely stateless, and all state made available by ASPNET is reconsti-
tuted, the event-driven model is really an emulation. ASP.NET performs quite a few tasks in the background in order
to support this model, as you’ll see in the following sections. The beauty of this concept is that the beginner pro-
grammer doesn’t need to be familiar with the underpinnings of the system to take advantage of server-side events.

Automatic Postbacks

Of course, one gap exists in the event system described so far. Windows developers have long been
accustomed to a rich event model that lets your code react to mouse movements, key presses, and
the minutest control interactions. But in ASPNET, client actions happen on the client side, and server
processing takes place on the web server. This means a certain amount of overhead is always involved
in responding to an event. For this reason, events that fire rapidly (such as a mouse move event) are
completely impractical in the world of ASPNET.

Note If you want to accomplish a certain Ul effect, you might handle rapid events such as mouse movements
with client-side JavaScript. (Or, better yet, you might use a custom ASP.NET control that already has these smarts
built in, like some sort of pop-up menu.) However, all your business code must execute in the secure, feature-rich
server environment.

If you're familiar with HTML forms, you know there is one basic way to submit a page—by
clicking a submit button. If you're using the standard HTML server controls, this is still your only
option. However, once the page is posted back, ASPNET can fire other events at the same time
(namely, events that indicate that the value in an input control has been changed).

Clearly, this isn’t enough to build a rich web form. Fortunately, ASPNET web controls extend this
model with an automatic postback feature. With this feature, input controls can fire different events,
and your server-side code can respond immediately. For example, you can trigger a postback when
the user clicks a check box, changes the selection in a list, or changes the text in a text box and then
moves to another field. These events still aren’t as fine-grained as events in a Windows application,
but they are a significant step up from the submit button.
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Automatic Postbacks “Under the Hood”

To use automatic postback, you simply need to set the AutoPostBack property of a web control to
True (the default is False, which ensures optimum performance if you don’t need to react to

a change event). When you do, ASPNET uses the client-side abilities of JavaScript to bridge the gap
between client-side and server-side code.

Here’s how it works: if you create a web page that includes one or more web controls that are
configured to use AutoPostBack, ASPNET adds a JavaScript function to the rendered HTML page
named __doPostBack(). When called, it triggers a postback, posting the page back to the web server
with all the form information.

ASPNET also adds two hidden input fields that the __doPostBack() function uses to pass infor-
mation back to the server. This information consists of the ID of the control that raised the event and
any additional information that might be relevant. These fields are initially empty, as shown here:

<input type="hidden" name="__EVENTTARGET" value="" />

<input type="hidden" name="__EVENTARGUMENT" value="" />

The _doPostBack() function has the responsibility for setting these values with the appropri-
ate information about the event and then submitting the form. A sample __doPostBack() function is
shown here:

<script type="text/javascript">

<l--
function _ doPostBack(eventTarget, eventArgument) {
if(!theForm.onsubmit || (theForm.onsubmit() != false)) {
theForm. EVENTTARGET.value = eventTarget;
theForm. EVENTARGUMENT.value = eventArgument;
theForm.submit();
}

}
/] -=>
</script>

Remember, ASPNET generates the __doPostBack() function automatically. This code grows
lengthier as you add more AutoPostBack controls to your page, because the event data must be set
for each control.

Finally, any control that has its AutoPostBack property set to True is connected to the
__doPostBack() function using the onClick or onChange attribute. These attributes indicate what
action the browser should take in response to the client-side JavaScript events onClick and onChange.

The following example shows the tag for a list control named IstCountry, which posts back
automatically. Whenever the user changes the selection in the list, the client-side onChange event
fires. The browser then calls the __doPostBack() function, which sends the page back to the server.

<select id="lstCountry" onchange="__doPostBack('lstCountry',"")"
language="javascript">

In other words, ASPNET automatically changes a client-side JavaScript event into a server-side
ASPNET event, using the __doPostBack() function as an intermediary. If you're a seasoned ASP
developer, you may have manually created a solution like this for traditional ASP web pages.
ASPNET handles these details for you automatically, simplifying life a great deal.

Tml%mmm%A$WEHMMMsMOmMmmmmmﬂmbm&MmsMMwaacmmMaMHmmmemw
functional web controls. Automatic postback is available only with web controls.




CHAPTER 3 " WEB FORMS 69

View State

The final ingredient in the ASPNET model is the new view state mechanism. View state solves
another problem that occurs because of the stateless nature of HTTP—lost changes.

Every time your page is posted back, you receive all the information that the user has entered in
any <input> controls in the <form> tag. ASPNET then loads the web page in its original state (based
on the layout and defaults you've defined) and tweaks the page according to this new information.
The problem is that in a dynamic web form, your code might change a lot more. For example, you
might programmatically change the color of a heading, modify a piece of static text, hide or show
a panel of controls, or even bind a full table of data to a grid. All these actions change the page from
its initial state. However, none of them is reflected in the form data that’s posted back. That means
this information will be lost after every postback. Traditionally, statelessness has been overcome
with the use of simple cookies, session-based cookies, and various other workarounds. All of these
mechanisms require homemade (and sometimes painstaking) measures.

To deal with this limitation, ASPNET has devised its own integrated state serialization mechanism.
Essentially, once your page code has finished running (and just before the final HTML is rendered
and sent to the client), ASPNET examines all the properties of all the controls on your page. If any of
these properties has been changed from its initial state, ASPNET makes a note of this information in
a name/value collection. Finally, ASPNET takes all the information it has amassed and then serializes
it as a Base64 string. (A Base64 string ensures that there aren't any special characters that wouldn’t
be valid HTML.) The final string is inserted in the <form> section of the page as a new hidden field.

When the page is posted back, ASPNET follows these steps:

1. ASPNET re-creates the page and control objects based on its defaults. Thus, the page has
the same state that it had when it was first requested.

2. Next, ASPNET deserializes the view state information and updates all the controls. This
returns the page to the state it was in before it was sent to the client the last time.

3. Finally, ASPNET adjusts the page according to the posted back form data. For example, if
the client has entered new text in a text box or made a new selection in a list box, that infor-
mation will be in the Form collection and ASPNET will use it to tweak the corresponding
controls. After this step, the page reflects the current state as it appears to the user.

4. Now your event-handling code can get involved. ASPNET triggers the appropriate events,
and your code can react to change the page, move to a new page, or perform a completely
different operation.

Using view state is a great solution because server resources can be freed after each request,
thereby allowing for scalability to support hundreds or thousands of requests without bogging the
server down. However, it still comes with a price. Because view state is stored in the page, it results
in a larger total page size. This affects the client doubly, because the client not only needs to receive
a larger page, but the client also needs to send the hidden view state data back to the server with the
next postback. Thus, it takes longer both to receive and post the page. For simple pages, this overhead
is minimal, but if you configure complex, data-heavy controls such as the GridView, the view state
information can grow to a size where it starts to exert a toll. In these cases, you can disable view state
for a control by setting its EnableViewState property to False. However, in this case you need to reini-
tialize the control with each postback.

Note Even if you set EnableViewState to False, the control can still hold onto a smaller amount of view state
information that it deems critical for proper functioning. This privileged view state information is known as contro/
state, and it can never be disabled. However, in a well-designed control the size required for control state will be
significantly smaller than the size of the entire view state. Control state is new in ASP.NET 2.0, and you’ll see how
it works when you design your own custom controls in Chapter 27.
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ASPNET uses view state only with page and control properties. ASPNET doesn't take the same
steps with member variables and other data you might use. However, as you'll learn later in this
book, you can place other types of data into view state and retrieve this information manually at
a later time.

Figure 3-2 provides an end-to-end look at page requests that puts all these concepts together.
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Figure 3-2. ASPNET page requests
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Note It is absolutely essential to your success as an ASPNET programmer to remember that the web form is
re-created with every round-trip. It does not persist or remain in memory longer than it takes to render a single request.

View State “Under the Hood”

If you look at the rendered HTML for an ASPNET page, you can easily find the hidden input field
with the view state information. The following example shows a page that uses a simple Label web
control and sets it with a dynamic “Hello, world” message:

<html>
<head runat="server"»>
<title>Hello World Page</title>
</head>
<body>
<form name="Form1" method="post" action="WebFormi.aspx" id="Formi">
<div>
<input type="hidden" name="__ VIEWSTATE" value="/wEPDwUKLTE2MjY5MTY1
NQ9kFgICAw9kFgICAQ8PFgIeBFR1eHQFDEh1bGXVIFdvemxkIWRkZPsbiNOyNAufEt70vNIbVYc
GWHgf" />

</div>
<div>
<input type="submit" name="Buttoni" value="Button" id="Button1" />
<span id="1bl">Hello, world</span>
</div>
</form>
</body>
</html>

The view state string isn't human readable—it just looks like a series of random characters.
However, it’'s important to note that a user who is willing to go to a little work can interpret this data
quite easily. Here’s a snippet of .NET code that does the job and writes the decoded information to
a web page:

viewStateString contains the view state information.

' Convert the Base64 string to an ordinary array of bytes

' representing ASCII characters.

Dim stringBytes As Byte() = Convert.FromBase64String(viewStateString)

Deserialize and display the string.
Dim decodedViewState As String = System.Text.Encoding.ASCII.GetString(stringBytes)
1bl.Text = decodedViewState

In the web page, you'll see something like this:

UbUd -162691655UdULLLLdULLLLUULUL-UTextd Hello, worldddd?L?¢ 24 U2 ¢2LIUZLIXZ

As you can see, the control text is clearly visible (along with some unprintable characters that
render as blank boxes). This means that, in its default implementation, view state isn’t a good place
to store sensitive information that the client shouldn’t be allowed to see—that sort of data should
stay on the server. Additionally, you shouldn't make decisions based on view state that could com-
promise your application if the client tampers with the view state data.

Fortunately, it’s possible to tighten up view state security quite a bit. You can enable automatic
hash codes to prevent view state tampering, and you can even encrypt view state to prevent it from
being decoded. These techniques raise hidden fields from a clumsy workaround to a much more robust
and respectable piece of infrastructure. You'll learn about both of these techniques in Chapter 6.
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Note If you've programmed with ASP.NET 1.x, you may have noticed that the view state serialization model in
ASP.NET 2.0 isn’t exactly the same. Instead of separating values with semicolons and angle brackets, ASP.NET 2.0
uses nonprintable characters, which makes parsing the string more efficient (because it’s easier to distinguish the
serialized data from the markers) and more compact. ASP.NET 2.0 also reduces the serialization size for many
common data types, including Boolean values, integers, and strings that are repeated more than once (which is
fairly common, because different controls often have the same property names). These seemingly minor changes
can have a dramatic effect. Depending on the number of delimiters in the serialized view state, and the types of
data types that are used, a data-heavy control can shrink its view state by half or more.

View State Chunking

The size of the hidden view state field has no limit. However, some proxy servers and firewalls refuse
to let pages through if they have hidden fields greater than a certain size. To circumvent this prob-
lem, you can use view state chunking, which automatically divides view state into multiple fields to
ensure that no hidden field exceeds a size threshold you set.

To use view state chunking, you simply need to set the maxPageStateFieldLength attribute of
the <pages> element in the web.config file. This specifies the maximum view state size, in bytes.
Here’s an example that caps view state at 1 KB:

<configuration xmlns="http://schemas.microsoft.com/.NetConfiguration/v2.0">
<system.web>
<pages maxPageStateFieldlLength = "1024" />
</system.web>
</configuration>

When you request a page that generates a view state larger than this, several hidden input
fields will be created:

<input type="hidden" name="__ VIEWSTATEFIELDCOUNT" value="3" />

<input type="hidden" name="__ VIEWSTATE" value="..." />
<input type="hidden" name="__ VIEWSTATE1" value="..." />
<input type="hidden" name="__ VIEWSTATE2" value="..." />

Remember, view state chunking is simply a mechanism for avoiding problems with certain
proxies (which is a relatively rare occurrence). View state chunking does not improve performance
(and adds a small amount of extra serialization overhead). As a matter of good design, you should
strive to include as little information in view state as possible, which ensures the best performance.

XHTML Compliance

In a major shift from ASPNET 1.x, the web controls in ASPNET 2.0 are compliant with the XHTML
1.1 standard. However, it’s still up to you to make sure the rest of your page behaves by the rules.
ASPNET doesn't take any steps to force XHTML compliance onto your page.

Note XHTML support doesn’t add any functionality to your web pages that you wouldn’t have with HTML 4.01.
However, because XHTML is a stricter standard, it has a few benefits. For example, you can validate XHTML pages
to catch minor errors that could trip up certain browsers. Most important, XHTML pages are also valid XML documents,
which makes it easier for applications to read or analyze them programmatically and introduces the possibility of
future extensibility. The current consensus is that XHTML will replace HTML in the future. You can learn more about
XHTML by referring to the specification at http://www.w3.org/TR/xhtml11.
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With a few exceptions, all the ASPNET server controls render themselves using XHTML-compliant
markup. That means this markup follows the rules of XHTML, which include the following:

* Tag and attribute names must be in lowercase.

¢ All elements must be closed, either with a dedicated closing tag (<p></p>) or using an empty
tag that closes itself (<br />).

» All attribute values must be enclosed in quotes (for example, type="text").

* The id attribute must be used instead of the name attribute.
XHTML also removes support for certain features that were allowed in HTML, such as frames
and inline formatting that doesn’t use CSS. In most cases, a suitable XHTML alternative exists. How-

ever, one sticking point is the target attribute, which HTML developers can use to create links that
open in new windows. The following ASPNET controls may use the target attribute:

* AdRotator

e TreeNode

* HyperLink

¢ HyperLinkColumn
* BulletedList

Using the target attribute won't cause a problem in modern browsers. However, if you need to
create a website that is completely XHTML-compliant, you should avoid these controls.

Note You won’t gain much, if anything, by using XHTML today. However, some companies and organizations
mandate the use of XHTML, namely, with a view to future standards. In the future, XHTML will make it easier to
design web pages that are adaptable to a variety of different platforms, can be processed by other applications,
and are extensible with new markup features. For example, you could use XSLT (XSL Transformations), another
XML-based standard, to transform an XHTML document into another form. The same features won’t be available to
HTML pages.

Document Type Definitions

Every XHTML document begins with a document type definition that defines the type of XHTML
your page uses. You place this immediately after the Page directive in the markup portion of your
web page. That way, the document type definition will be rendered as the first line of your document,
which is a requirement.

Here’s an example that defines a web page that supports XHTML 1.1:

<%@ Page Language="vb" AutoEventWireup="true"
CodeFile="TestPage.aspx.vb" Inherits="_TestPage" %>

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.1//EN"
"http://www.w3.0rg/TR/xhtml11/DTD/xhtml11.dtd">

<html xmlns="http://www.w3.0rg/1999/xhtml" >
<head runat="server">
<title>Untitled Page</title>
</head>
<body>
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<form id="form1" runat="server">
<div>

</div>

</form>
</body>
</html>

The page also defines the XML namespace for the <html> element. This is another detail that
XHTML requires but ASPNET doesn’t supply automatically.

Note When you create a web page in Visual Studio, it sets the XML namespace for the <html> element, and it
adds a doctype for XHTML 1.1. You can change this doctype (or even remove it entirely).

If you don’'t want to support the full XHTML 1.1 standard, you can make a few compromises.
Some other common choices for doctype include XHTML 1.0 transitional, which enforces the struc-
tural rules of XHTML but allows HTML formatting features that have been replaced by stylesheets
and are considered obsolete. Here’s the doctype you need:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"
"http://www.w3.0rg/TR/xhtml1/DTD/xhtml1-transitional.dtd">

The XHTML transitional doctype considers HTML frames obsolete. If you need to create
a frames page, consider the XHTML 1.0 frameset doctype:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Frameset//EN"
"http://www.w3.0rg/TR/xhtml1/DTD/xhtml1-frameset.dtd">

Remember, the ASPNET server controls will work equally well with any doctype (and they will
work with browsers that support only HTML as well). It’s up to you to choose the level of standards
compliance (and backward compatibility) you want in your web pages.

Note If you're really intent on following the rules of the XHTML standard, you can choose to render your page
using the MIME content type application/xhtml+xml instead of the standard text/html. This change is an XHTML
recommendation, and it’s designed to help browsers and other applications distinguish between ordinary HTML
pages and XHTML. Unfortunately, at the time of this writing Internet Explorer still doesn’t support the application/
xhtml+xml content type (unlike almost all other modern browsers). If you still want to implement the change, just
add the attribute ContentType="application/xhtml+xml" to the Page directive.

XHTML Validation

The core ASPNET controls follow the rules of XHTML, but to make sure the finished page is XHTML-
compliant, you need to make sure any static content you add also follows these rules. Visual Studio
can help you with its own built-in validator. Just select the target standard from the drop-down list
in the HTML Source Editing toolbar. For example, if you choose XHTML 1.1, Visual Studio flags
structural errors and obsolete tags (see Figure 3-3).
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Figure 3-3. Validating for XHTML 1.1 in Visual Studio

Remember, if you violate the rules of XHTML, your browser probably won't flag the error. To
create an XHTML-compliant page, you can use Visual Studio.NET IntelliSense, but that forces you to
work with the page source, and it doesn’'t guarantee the final page won't contain an XHTML violation.
(For example, you might use a third-party control that renders markup that isn't XHTML-compliant.)
To give your pages the acid test, use a third-party validator that can request your page and scan it for
erTors.

One good resource is the free W3C validation service at http://validator.w3.org. Simply enter
the URL to your web page, and click Check. You can also upload a file to check it, but in this case you
must make sure you upload the final rendered page, not the .aspx source. You can see (and save) the
rendered content for a page in Internet Explorer by choosing View » Source.

Disabling XHTML Rendering

The ASPNET server controls automatically use XHTML markup if the requesting browser supports
HTML 4.0 or later. However, there may be rare cases when you want to disable XHTML-compliant
rendering altogether. This might be the case if you have client-side JavaScript that relies on tags or
attributes that aren't allowed in XHTML. To solve this problem, you can revert to the HTML render-
ing used in ASPNET 1.x.
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To revert to HTML-only rendering, you simple need to set the enableLegacyRendering attribute
of the xhtml11Conformance element to True in your web.config file. Here’s an example:

<system.web>
<xhtmli1Conformance enablelLegacyRendering="true" />
</system.web>

When obsolete rendering is enabled, ASPNET controls do not use any of the XHTML refinements
that aren’t strictly compatible with HTML 4.01. For example, they render standard HTML elements
such as <br> instead of the correct XHTML version <br />. However, even if obsolete rendering is
enabled, ASPNET won'’t strip out the namespace in the <html> tag or remove the doctype if these
details are present in your page.

Note ASPNET makes no guarantee that the enableLegacyRendering attribute will be supported in future versions
of ASP.NET, so use it only if it’s required for a specific scenario.

Web Forms Processing Stages

On the server side, processing an ASPNET web form takes place in stages. At each stage, various
events are raised. This allows your page to plug into the processing flow at any stage and respond
however you would like.

The following list shows the major stages in the process flow of an ASPNET page:

* Page framework initialization

* User code initialization

* Validation

¢ Event handling

* Automatic data binding

e Cleanup
Remember, these stages occur independently for each web request. Figure 3-4 shows the order

in which these stages unfold. More stages exist than are listed here, but those are typically used for
programming your own ASPNET controls and aren’t handled directly by the page.
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Figure 3-4. ASPNET page life cycle

In the next few sections you’ll learn about each stage and then examine a simple web page
example.

Page Framework Initialization

This is the stage in which ASPNET first creates the page. It generates all the controls you have
defined with tags in the .aspx web page. In addition, if the page is not being requested for the first
time (in other words, if it’s a postback), ASPNET deserializes the view state information and applies
it to all the controls.

At this stage, the Page.Init event fires. However, this event is rarely handled by the web page,
because it’s still too early to perform page Ul rendering.

User Code Initialization

At this stage of the processing, the Page.Load event is fired. Most web pages handle this event to
perform any required initialization (such as filling in dynamic text or configuring controls).

The Page.Load event always fires, regardless of whether the page is being requested for the first
time or whether it is being requested as part of a postback. Fortunately, ASPNET provides a way to
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allow programmers to distinguish between the first time the page is loaded and all subsequent
loads. Why is this important? First, since view state is maintained automatically, you have to fetch
your data from a dynamic data source only on the first page load. On a postback, you can simply sit
back, relax, and let ASPNET restore the control properties for you from the view state. This can pro-
vide a dramatic performance boost if the information is expensive to re-create (for example, if you
need to query it from a database). Second, there are also other scenarios, such as edit forms and
drill-down pages, in which you need the ability to display one interface on a page’s first use and
a different interface on subsequent loads.

To determine the current state of the page, you can check the Shared Page.IsPostBack property,
which will be False the first time the page is requested. Here’s an example:

If (Not Page.IsPostBack) Then
" It's safe to initialize the controls for the first time.
FirstName.Text = "Enter your name here"

End If

Note IsPostBack is a Shared property of the Page class. It always returns the information based on the current
page. You can also use the instance property IsPostBack (as in Me.IsPostBack), which returns the same value.
Which approach you use is simply a matter of preference.

Remember, view state stores every changed property. Initializing the control in the Page.Load
event counts as a change, so any control value you touch will be persisted in view state, needlessly
enlarging the size of your page and slowing transmission times. To streamline your view state and
keep page sizes small, avoid initializing controls in code. Instead, set the properties in the control
tag (either by editing the tag by hand in source view or by using the Properties window). That way;,
these details won't be persisted in view state. In cases where it really is easier to initialize the control
in code, consider disabling view state for the control by setting EnableViewState to False and initial-
izing the control every time the Page.Load event fires, regardless of whether the current request is
a postback.

Validation

ASPNET introduces new validation controls that can automatically validate other user input con-
trols and display error messages. These controls fire after the page is loaded but before any other
events take place. However, the validation controls are for the most part self-sufficient, which
means you don't need to respond to the validation events. Instead, you can just examine whether
the page is valid (using the Page.IsValid property) in another event handler. Chapter 4 discusses the
validator controls in more detail.

Event Handling

At this point, the page is fully loaded and validated. ASPNET will now fire all the events that have
taken place since the last postback. For the most part, ASPNET events are of two types:

Immediate response events: These include clicking a submit button or clicking some other
button, image region, or link in a rich web control that triggers a postback by calling the
__doPostBack() JavaScript function.

Change events: These include changing the selection in a control or the text in a text box. These
events fire immediately for web controls if AutoPostBack is set to True. Otherwise, they fire the
next time the page is posted back.
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As you can see, ASPNET’s event model is still quite different from a traditional Windows envi-
ronment. In a Windows application, the form state is resident in memory, and the application runs
continuously. That means you can respond to an event immediately. In ASPNET, everything occurs
in stages, and as a result events are sometimes batched together.

For example, imagine you have a page with a submit button and a text box that doesn’t post
back automatically. You change the text in the text box and then click the submit button. At this
point, ASPNET raises all of the following events (in this order):

* Page.lnit

* Page.Load

» TextBox.TextChanged
* Button.Click

e Page.PreRender
 Page.Unload

Remembering this bit of information can be essential in making your life as an ASPNET pro-
grammer easier. There is an upside and a downside to the event-driven model. The upside is that
the event model provides a higher level of abstraction, which keeps your code clear of boilerplate
code for maintaining state. The downside is that it’s easy to forget that the event model is really just
an emulation. This can lead you to make an assumption that doesn’t hold true (such as expecting
information to remain in member variables) or a design decision that won'’t perform well (such as
storing vast amounts of information in view state).

Automatic Data Binding

In Chapter 9, you'll learn about the data source controls (new in ASPNET 2.0), which automate the
data binding process. When you use the data source controls, ASPNET automatically performs
updates and queries against your data source as part of the page life cycle.

Essentially, two types of data source operations exist. Any changes (inserts, deletes, or updates)
are performed after all the control events have been handled but just before the Page.PreRender event
fires. Then, after the Page.PreRender event fires, the data source controls perform their queries and
insert the retrieved data into any linked controls. This model makes instinctive sense, because if
queries were executed before updates, you could end up with stale data in your web page. However,
this model also introduces a necessary limitation—none of your other event handlers will have access
to the most recent data, because it hasn't been retrieved yet.

This is the last stop in the page life cycle. Historically, the Page.PreRender event is supposed to
signify the last action before the page is rendered into HTML (although, as you've just learned, some
data binding work can still occur after the prerender stage). During the prerender stage, the page and
control objects are still available, so you can perform last-minute steps such as storing additional
information in view state.

To learn much more about the ASPNET data binding story, refer to Chapter 9.

Cleanup

At the end of its life cycle, the page is rendered to HTML. After the page has been rendered, the real
cleanup begins, and the Page.Unload event is fired. At this point, the page objects are still available,
but the final HTML is already rendered and can't be changed.

Remember, the NET Framework has a garbage collection service that runs periodically to release
memory tied to objects that are no longer referenced. If you have any unmanaged resources to release,
you should make sure you do this explicitly in the cleanup stage or, even better, before. When the
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garbage collector collects the page, the Page.Disposed event fires. This is the end of the road for the
web page at the server. Control returns to the browser.

A Page Flow Example

No matter how many times people explain how something works, it’s always more satisfying to see
it for yourself (or break it trying to learn how it works). To satisfy your curiosity, you can build a sam-
ple web form test that illustrates the flow of processing. About the only thing this example won’t
illustrate is validation (which is discussed in the next chapter).

To try this, start by creating a new web form named PageFlow.aspx. In Visual Studio, you simply
need to drag two controls (a label and button) onto the design surface from the Web Forms section
of the toolbox. This generates a server-side <form> tag with the two control tags that you need in
the .aspx file. Next, select the Label control. Using the Properties window, set the ID property to
IblInfo and the EnableViewState property to False.

Here’s the complete markup for the .aspx file:

<%@ Page language="vb" CodeFile="PageFlow.aspx.vb"
AutoEventWireup="true" Inherits="PageFlow" %>
<html>
<head runat="server">
<title>Page Flow</title>

</head>
<body>
<form id="form1" runat="server">
<div>
<p>
<asp:label id="1blInfo" runat="server" EnableViewState="False">
</asp:Label>
</p>
<p>
<asp:Button id="Button1" runat="server" Text="Button">
</asp:Button>
</p>
</div>
</form>
</body>
</html>

The next step is to add your event handlers. When you're finished, the code-behind file will hold
five event handlers that respond to different events, including Page.Init, Page.Load, Page.PreRender,
Page.Unload, and Button.Click.

Page event handlers are a special case. Unlike other controls, you don’'t need to wire them up
using attributes in your markup. Instead, page event handlers are automatically connected pro-
vided they use the correct method name. Here are the event handlers for various page events in the
PageFlow example:

Protected Sub Page Load(ByVal sender As Object, ByVal e As System.EventArgs)
1blInfo.Text &= "Page.Load event handled.<br />"
If Page.IsPostBack Then
1blInfo.Text &= "<b>This is the second time you've seen this page.</b><br />"
End If
End Sub

Protected Sub Page Init(ByVal sender As Object, ByVal e As System.EventArgs)
1blInfo.Text &= "Page.Init event handled.<br />"
End Sub
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Protected Sub Page PreRender(ByVal sender As Object, ByVal e As System.EventArgs)
1blInfo.Text &= "Page.PreRender event handled.<br />"
End Sub

Protected Sub Page Unload(ByVal sender As Object, ByVal e As System.EventArgs)
' This text never appears because the HTML is already
' rendered for the page at this point.
1blInfo.Text &= "Page.Unload event handled.<br />"
End Sub

Each event handler simply adds to the text in the Text property of the label. When the code
adds this text, it also uses embedded HTML tags such as <b> (to bold the text) and <br /> (to insert
aline break). Another option would be to create separate Label controls and configure the style-
related properties of each one.

Note In this example, the EnableViewState property of the label is set to False. This ensures that the text is
cleared every time the page is posted back and the text that’s shown corresponds only to the most recent batch of
processing. If you left EnableViewState set to True, the list would grow longer with each postback, showing you all
the activity that has happened since you first requested the page.

Additionally, you need to wire up an event handler for the Button.Click event, as shown here:

Protected Sub Buttoni Click(ByVal sender As Object, ByVal e As System.EventArgs)
1blInfo.Text &= "Buttoni.Click event handled.<br />"
End Sub

You may have noticed that the Button.Click event handler requires a different accessibility level
than the page event handlers. The page event handlers are Private, and all control event handlers are
Protected. To understand this difference, you need to reconsider the code model that was introduced
in Chapter 2.

Page handlers are hooked up explicitly using the code editor. You simply select the (Page Events)
item on the left menu, and the appropriate Event on the right menu. The declaration will be generated
for you by the IDE.

Control event handlers are connected using a different mechanism—the control tag. They are
bound at a later stage of processing, after the markup in the .aspx file and the code-behind class
have been merged together. ASPNET creates this merged class by deriving a new class from the
code-behind class.

Here’s where things get tricky. This derived class needs to be able to access the event handlers
in the page so it can connect them to the appropriate controls. The derived class can access the
event handlers only if they are Public (in which case any class can access them) or Protected (in
which case any derived class can access them).

Tip Although it’s acceptable for page event handlers to be Private, it’s a common convention in ASP.NET 2.0
code to make all event handlers Protected, just for consistency and simplicity.

Figure 3-5 shows the ASPNET page after clicking the button, which triggers a postback and the
Buttonl1.Click event. Note that even though this event caused the postback, Page.Init and Page.Load
were both raised first.
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Figure 3-5. ASPNET order of operations

The Page As a Control Container

Now that you've learned the stages of web forms processing, it’s time to take a closer look at how the
server control model plugs into this pipeline. To render a page, the web form needs to collaborate
with all its constituent controls. Essentially, the web form renders itself and then asks all the controls
on the page to render themselves. In turn, each of those controls can contain child controls; each is
also responsible for their own rendering code. As these controls render themselves, the page assem-
bles the generated HTML into a complete page. This process may seem a little complex at first, but it
allows for an amazing amount of power and flexibility in creating rich web-page interfaces.

When ASPNET first creates a page (in response to an HTTP request), it inspects the .aspx file.
For each control tag it finds, it creates and configures a control object, and then it adds this control
as a child control of the page. You can examine the Page.Controls collection to find all the child con-
trols on the page.

Showing the Control Tree

Here’s an example that looks for controls. Each time it finds a control, the code uses the Reponse.Write()
command to write the control class type and control ID to the end of the rendered HTML page, as
shown here:

For Each control As Control In Page.Controls
Response.Write(control.GetType().ToString() _
& " - <b>" & control.ID & "</b><br />")
Next control
' Separate this content from the rest of the page with a horizontal line.
Response.Write("<hr />")

This code can reside behind a button on your page or even in Page_Load().

Note The Response.Write() method is a holdover from classic ASP, and you should never use it in a real-world
ASP.NET web application. It effectively bypasses the web control model, which leads to disjointed interfaces, com-
promises ASP.NET’s ability to create markup that adapts to the target device, and almost always breaks XHTML
compatibility. However, in this test page Response.Write() allows you to write raw HTML without generating any
additional controls—which is a perfect technique for analyzing the controls on the page without disturbing them.
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To test this code, you can add it to the Page.Load event handler. In this case, the rendered
content will be written at the top of the page before the controls. However, when you run it, you'll
notice some unexpected behavior. For example, consider the web form shown in Figure 3-6, which
contains several controls, some of which are organized into a box using the Panel web control. It
also contains two lines of static HTML text.

2 Controls - Microsoft Internet Explorer

Fle Edit Yiew Favorites Tools  Help J 3] |ﬂ @ ;‘ L))

Address |@j http:f/localhost/ChapterD4/Controls . aspx M |

Thiz iz static HTML fnot a web control).

[ Button1 H Button2 ][ Buttan3 ]

Name | |

This is static HTML fnat @ web contral).

&] Done % J Local intranet

Figure 3-6. A sample web page with multiple controls

Here’s the .aspx markup code for the page:

<%@ Page language="vb" CodeFile="MyControls.aspx.vb" AutoEventWireup="true"
Inherits="MyControls" %>
<html>
<head>
<title>Controls</title>
</head>
<body>
<p><i>This is static HTML (not a web control).</i></p>
<form id="Controls" method="post" runat="server">
<div>
<asp:panel id="MainPanel" runat="server" Height="112px">
<p><asp:Button id="Buttoni" runat="server" Text="Button1"/>
<asp:Button id="Button2" runat="server" Text="Button2"/>
<asp:Button id="Button3" runat="server" Text="Button3"/></p>
<p><asp:Label id="Label1" runat="server" Width="48px">
Name:</asp:Label>
<asp:TextBox id="TextBox1" runat="server"></asp:TextBox></p>
</asp:panel>
<p><asp:Button id="Button4" runat="server" Text="Button4"/></p>
</div>
</form>
<p><i>This is static HTML (not a web control).</i></p>
</body>
</html>
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When you run this page, you won'’t see a full list of controls. Instead, you'll see a list that names
only three controls, as shown in Figure 3-7.

2} Controls - Microsoft Internet Explorer E”Elb_?l
Fil= Edt ‘Wew Favorites Tools  Help 9 >) |i'] @ll 1.\ l.;'
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System. Web. UL HiralControls HimlF orm - Controls
System Web TT Literal Control -

This i siatic HTML (kat a web controll.

Button1 ][ Button2 ][ Button3 ]

IMame:

Thiz iz static HTML (not a web contrall.

&] Done & Local intranet

Figure 3-7. Controls on the top layer of the page

ASPNET models the entire page using control objects, including elements that don't corre-
spond to server-side content. For example, if you have one server control on a page, ASPNET will
create a LiteralControl that represents all the static content before the control and will create another
LiteralControl that represents the content after it. Depending on how much static content you have
and how you break it up between other controls, you may end up with multiple LiteralControl objects.

LiteralControl objects don’t provide much in the way of functionality. For example, you can't set
style-related information such as colors and font. They also don’t have a unique server-side ID.
However, you can manipulate the content of a LiteralControl using its Text property. The following
code rewrites the earlier example so that it checks for literal controls, and, if present, it casts the
base Control object to the LiteralControl type so it can extract the associated text:

For Each control As Control In Page.Controls
Response.Write(control.GetType().ToString() _
& " - <b>" & control.ID + "</b><br />")

If TypeOf control Is LiteralControl Then
' Display the literal content (whitespace and all).
Response.Write("*** Text: " & (CType(control, LiteralControl)).Text _
& "<br />")
End If
Next control
Response.Write("<hr>")

This example still suffers from a problem. You now understand the unexpected new content,
but what about the missing content—namely, the other control objects on the page?
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To answer this question, you need to understand that ASPNET renders a page hierarchically. It
directly renders only the top level of controls. If these controls contain other controls, they provide
their own Controls properties, which provide access to their child controls. In the example page, as
in all ASPNET web forms, all the controls are nested inside the <form> tag. This means you need to
inspect the Controls collection of the HtmlForm class to get information about the server controls
on the page.

However, life isn't necessarily this straightforward. That’s because there’s no limit to how many
layers of nested controls you can use. To really solve this problem and display all the controls on
a page, you need to create a recursive routine that can tunnel through the entire control tree.

The following code shows the complete solution:

Partial Class Controls
Inherits System.Web.UI.Page

Protected Sub Page Load(ByVal sender As Object, ByVal e As System.EventArgs)
' Start examining all the controls.
DisplayControl(Page.Controls, 0)
' Add the closing horizontal line.
Response.Write("<hr/>")
End Sub

Private Sub DisplayControl(ByVal controls As ControlCollection,
ByVal depth As Integer)
For Each control As Control In controls
' Use the depth parameter to indent the control tree.
Response.Write(New String("-"c, depth * 4) & "> ")

' Display this control.
Response.Write(control.GetType().ToString() & " - <b>
& control.ID & "</b><br />")
If control.Controls IsNot Nothing Then
DisplayControl(control.Controls, depth + 1)
End If
Next control
End Sub

End Class

Figure 3-8 shows the new result—a hierarchical tree that shows all the controls on the page and
their nesting.

85



86 CHAPTER 3 © WEB FORMS
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Figure 3-8. A tree of controls on the page

The Page Header

As you've seen, you can transform any HTML element into a server control with the runat="server"
attribute, and a page can contain an unlimited number of HTML controls. In addition to the controls
you add, a web form can also contain a single HtmlHead control, which provides server-side access
to the <head> tag.

The control tree shown in the previous example doesn’t include the HtmlHead control, because
the runat="server" attribute hasn't been applied to the <head> tag. However, the Visual Studio default
is to always make the <head> tag into a server-side control, in contrast to previous versions of ASPNET.

As with other server controls, you can use the HtmlHead control to programmatically change
the content that’s rendered in the <head> tag. The difference is that the <head> tag doesn’t corre-
spond to actual content you can see in the web page. Instead, it includes other details such as the
title, metadata tags (useful for providing keywords to search engines), and stylesheet references. To
change any of these details, you use one of a small set of members that are defined in the IPageHeader
interface. The HtmlHead control implements the IPageHeader interface. It includes the following
properties:

Title: This is the title of the HTML page, which is usually displayed in the browser’s title bar. You
can modify this at runtime.

LinkedStyleSheets: This provides access to a collection of IStyleSheet objects (CSS stylesheets),
one for each stylesheet that’s linked to your web page through the header. You'll learn more
about stylesheets in Chapter 15.

StyleSheet: This provides an IStyleSheet object that represents inline styles defined in the header.

Metadata: This provides a collection of metadata tags. You can add or remove entries at runtime.
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Out of this list, the Metadata property is the most useful. Here’s an example that sets some
header information programmatically:

Page.Header.Title = "Dynamically Titled Page"
Page.Header.Metadata.Add("Keywords", ".NET, VB.NET, ASP.NET")
Page.Header.Metadata.Add("Description”, "A great website to learn .NET")

Tip The HtmlHead control is handy in pages that are extremely dynamic. For example, if you build a data-driven
website that serves promotional content from a database, you might want to change the keywords and title of the
page depending on the content you use when the page is requested.

Dynamic Control Creation

Using the Controls collection, you can create a control and add it to a page programmatically. Here’s
an example that generates a new button and adds it to a Panel control on the page:

Protected Sub Page Load(ByVal sender As Object, ByVal e As System.EventArgs)
Dim newButton As Button = New Button()
' Assign some text and an ID so you can retrieve it later.
newButton.Text = "* Dynamic Button *"
newButton.ID = "newButton"
' Add the button to a Panel.
MyPanel.Controls.Add(newButton)
End Sub

You can execute this code in any event handler. However, because the page is already created,
this code always adds the new control at the end of the collection. In this example, that means the
new button will end up at the bottom of the Panel control.

To get more control over where a dynamically added control is positioned, you can use
a PlaceHolder. A PlaceHolder is a control that has no purpose except to house other controls. If you
don’t add any controls to the Controls collection of the PlaceHolder, it won't render anything in the
final web page. However, Visual Studio gives a default representation that looks like an ordinary label
at design time, so you can position it exactly where you want. That way, you can add a dynamic
control between other controls.

' Add the button to a PlaceHolder.
PlaceHolder1.Controls.Add(newButton)

When using dynamic controls, you must remember that they will exist only until the next post-
back. ASPNET will not re-create a dynamically added control. If you need to re-create a control multiple
times, you should perform the control creation in the Page.Load event handler. This has the additional
benefit of allowing you to use view state with your dynamic control. Even though view state is nor-
mally restored before the Page.Load event, if you create a control in the handler for the Page.Load
event, ASPNET will apply any view state information that it has after the Page.Load event handler
ends. This process is automatic.

If you want to interact with the control later, you should give it a unique ID. You can use this ID
to retrieve the control from the Controls collection of its container. You could find the control using
recursive searching logic, as demonstrated in the control tree example, or you can use the Shared
Page.FindControl() method, which searches the entire page for the control with the ID you specify.
Here’s an example that searches for the dynamically added control with the FindControl() method
and then removes it:
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Protected Sub cmdRemove Click(ByVal sender As Object, ByVal e As System.EventArgs)
' Search for the button, no matter what level it's at.
Dim foundButton As Button = CType(Page.FindControl("newButton"), Button)

Remove the button.
If foundButton IsNot Nothing Then
foundButton.Parent.Controls.Remove(foundButton)
End If
End Sub

Dynamically added controls can handle events. All you need to do is attach an event handler
using delegate code. You must perform this task in your Page.Load event handler. As you learned
earlier, all control-specific events are fired after the Page.Load event. If you wait any longer, the
event handler will be connected after the event has already fired, and you won't be able to react to it
any longer.

' Attach an event handler to the Button.Click event.
AddHandler newButton.Click, AddressOf Me.Button Click

Figure 3-9 demonstrates all these concepts. It generates a dynamic button. When you click
this button, the text in a label is modified. Two other buttons allow you to dynamically remove or
re-create the button.

2l DynamicButton - Microsoft Internet Explorer

Ele Edt Wiew Favorites Tools  Help -G Back ~ ) Iﬂ IEI] o

Address @ http:{ flocalhost{Chapteri4DynamicEutton, aspx s

Tou clicked the dynamic button.

[ * Dynarmic Button * ] [ Reset Text ]

[ Create Button ] [ Remove Button ]

& Done % Local intranet

Figure 3-9. Handling an event from a dynamically added control

Dynamic control creation is particularly powerful when you combine it with user controls
(reusable blocks of user interface that can combine a group of controls and HTML). You'll learn
more about user controls in Chapter 14.

The Page Class

Now that you've explored the page life cycle and learned how a page contains controls, it’s worth
pointing out that the page itself is also instantiated as a type of control object. In fact, all web forms
are actually instances of the ASPNET Page class, which is found in the System.Web.UI namespace.
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You may have already figured this out by noticing that every code-behind class explicitly derives
from System.Web.UIPage. This means that every web form you create is equipped with an enormous
amount of out-of-the-box functionality. The Shared FindControl() method and the IsPostBack prop-
erty are two examples you've seen so far. In addition, deriving from the Page class gives your code
the following extremely useful properties:

¢ Session

e Application
e Cache

* Request

* Response
¢ Server

e User

e Trace

Many of these properties correspond to intrinsic objects that you could use in classic ASP web
pages. However, in classic ASP you accessed this functionality through built-in objects that were
available at all times. In ASPNET, each of these built-in objects actually corresponds to a Page prop-
erty that exposes an instance of a full-featured class.

The following sections introduce these objects.

Session, Application, and Cache

The Session object is an instance of the System.Web.SessionState.HttpSessionState class. It’s designed
to store any type of user-specific data that needs to persist between web-page requests. The Session
object provides dictionary-style access to a set of name/value pairs that represents the user’s data
for that session. Session state is often used to maintain things such as the user’s name, the user’s ID,
a shopping cart, or various other elements that are discarded when a given user is no longer access-
ing pages on the website.

The Application object is an instance of the System.Web.HttpApplicationState class. Like the
Session object, it’s also a name/value dictionary of data. However, this data is global to the entire
application.

Finally, the Cache object is an instance of the System.Web.Caching.Cache class. It also stores
global information, but it provides a much more scalable storage mechanism because ASPNET can
remove objects if server memory becomes scarce. Like the other state collections, it’s essentially
a name/value collection of objects, but you can also set specialized expiration policies and depen-
dencies for each item.

Deciding how to implement state management is one of the key challenges of programming
a web application. You'll learn much more about all these types of state management in Chapter 6.

Request

The Request object is an instance of the System.Web.HttpRequest class. This object represents the
values and properties of the HTTP request that caused your page to be loaded. It contains all the URL
parameters and all other information sent by a client. Much of the information provided by the Request
object is wrapped by higher-level abstractions (such as the ASPNET web control model), so it isn’t
nearly as important as it was in classic ASP. However, you might still use the Request object to find
out what browser the client is using or to set and examine cookies.
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Table 3-1 describes some of the more common properties of the Request object.

Table 3-1. HttpRequest Properties

Property

Description

PhysicalApplicationPath and PhysicalPath

AnonymousID

Browser

ClientCertificate

Cookies

FilePath and CurrentExecutionFilePath

Form

Headers and ServerVariables

IsAuthenticated and IsSecureConnection

IsLocal

QueryString

Url and UrlReferrer

UserAgent

PhysicalApplicationPath gets the ASPNET application’s
virtual directory (URL), while PhysicalPath gets the
“real” directory.

This uniquely identifies the current user if you've
enabled anonymous access. You'll learn how to use
the new anonymous access features in Chapter 24.

This provides a link to an HttpBrowserCapabilities
object, which contains properties describing various
browser features, such as support for ActiveX controls,
cookies, VBScript, and frames.

This is an HttpClientCertificate object that gets the
security certificate for the current request, if there
is one.

This gets the collection cookies sent with this
request. Chapter 6 discusses cookies.

These return the real file path (relative to the server)
for the currently executing page. FilePath gets the
page that started the execution process. This is the
same as CurrentExecutionFilePath, unless you've
transferred the user to a new page without a redirect
(for example, using the Server.Transfer() method), in
which case CurrentExecutionFilePath reflects the
new page and FilePath indicates the original page.

This represents the collection of form variables that
were posted back to the page. In almost all cases,
you'll retrieve this information from control properties
instead of using this collection.

These provide a name/value collection of HTTP
headers and server variables. You can get the low-level
information you need if you know the corresponding
header or variable name.

These return True if the user has been successfully
authenticated and if the user is connected over SSL
(Secure Sockets Layer).

This returns True if the user is requesting the page
from the current computer.

This provides the parameters that were passed
along with the query string. Chapter 6 shows how
you can use the query string to transfer information
between pages.

These provide a Url object that represents the current
address for the page and the page where the user is
coming from (the previous page that linked to this
page).

This is a string representing the browser type. Internet
Explorer provides the value MSIE for this property.
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Property Description

UserHostAddress and UserHostName These get the IP address and the DNS name of the
remote client. You could also access this information
through the ServerVariables collection. However, this
information may not always be available.

UserLanguages This provides a sorted string array that lists the client’s
language preferences. This can be useful if you need
to create multilingual pages.

Response

The Response object is an instance of the System.Web.HttpResponse class, and it represents the
web server’s response to a client request. In classic ASP, the Response object was the only way to
programmatically send HTML text to the client. Now server-side controls have nested, object-oriented
methods for rendering themselves. All you have to do is set their properties. As a result, the Response
object doesn't play nearly as central a role.

The HttpResponse does still provide some important functionality—namely, cookie features
and the Redirect() method. The Redirect() method allows you to send the user to another page. Here’s
an example:

' You can redirect to a page in the current directory.
Response.Redirect("newpage.aspx")

" You can redirect to another website.
Response.Redirect("http://www.prosetech.com")

The Redirect() method requires a round-trip. Essentially, it sends a message to the browser that
instructs it to request a new page. If you want to transfer the user to another page in the same web
application, you can use a faster approach with the Server.Transfer()method.

Tip Another way also exists to get from one page to the next—cross-page posting. Using this technique, you
can create a page that posts itself to another page, which allows you to effectively transfer all the view state infor-
mation and the contents of any controls. You'll learn how to use this technique in Chapter 6.

Table 3-2 lists common HttpResponse members.

Table 3-2. HttpResponse Members

Member Description

BufferOutput When set to True (the default), the page isn’t sent to the
client until it's completely rendered and ready to be sent,
as opposed to being sent piecemeal.

Cache This references an HttpCachePolicy object that allows
you to configure output caching. Chapter 11 discusses
caching.

Cookies This is the collection of cookies sent with the response.

You can use this property to add additional cookies.

Expires and ExpiresAbsolute You can use these properties to cache the rendered
HTML for the page, improving performance for
subsequent requests. You'll learn about this type of
caching (known as output caching) in Chapter 11.

(Continued)
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Table 3-2. Continued

Member

Description

IsClientConnected

Write(), BinaryWrite(), and WriteFile()

Redirect()

This is a Boolean value indicating whether the client is
still connected to the server. If it isn’t, you might want to
stop a time-consuming operation.

These methods allow you to write text or binary content
directly to the response stream. You can even write the
contents of a file. These methods are de-emphasized in
ASPNET and shouldn’t be used in conjunction with
server controls.

This method transfers the user to another page in your
application or a different website.

Server

The Server object is an instance of the System.Web.HttpServerUtility class. It provides a handful of
miscellaneous helper methods and properties, as listed in Table 3-3.

Table 3-3. HttpServerUtility Methods

Method

Description

MachineName

CreateObject()

GetLastError()

HtmlEncode() and HtmlDecode()
UrlEncode() and UrlDecode()

UrlTokenEncode () and UrlTokenDecode)

MapPath()

Transfer()

A property representing the computer name of the
server on which the page is running. This is the
name the web server computer uses to identify
itself to the rest of the network.

Creates an instance of the COM object that is
identified by its progID (programmatic ID). This is
included for backward compatibility, because it will
generally be easier to interact with COM objects
using .NET’s support for COM interop, which
provides strongly typed interaction.

Retrieves the exception object for the most recently
encountered error (or a null reference, if there isn’t
one). This error must have occurred while processing
the current request, and it must not have been
handled. This is most commonly used in an appli-
cation event handler that checks for error conditions
(an example of which you’ll see in Chapter 5).

Changes an ordinary string into a string with legal
HTML characters (and back again).

Changes an ordinary string into a string with legal
URL characters (and back again).

Performs the same work as UrlEncode() and
UrlDecode(), except they work on a byte array that
contains Base64-encoded data.

Returns the physical file path that corresponds to
a specified virtual file path on the web server.

Transfers execution to another web page in the
current application. This is similar to the
Response.Redirect() method, but it’s faster. It
cannot be used to transfer the user to a site on
another web server or to a non-ASPNET page (such
as an HTML page or an ASP page).
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The Transfer() method is the quickest way to redirect the user to another page in your application.
When you use this method, a round-trip is not involved. Instead, the ASPNET engine simply loads
the new page and begins processing it. As a result, the URL that’s displayed in the client’s browser
won't change.

' You can transfer to a file in the current web application.
Server.Transfer("newpage.aspx")

' You can't redirect to another website.
This attempt will cause an error.
Server.Transfer ("http://www.apress.com")

The MapPath() method is another useful method of the Server object. For example, imagine you
want to load a file named info.txt from the current virtual directory. Instead of hard-coding the path,
you can use Request.ApplicationPath() to get the current relative virtual directory and Server.MapPath()
to convert this to an absolute physical path. Here’s an example:

Dim physicalPath As String = Server.MapPath(Request.ApplicationPath & "/info.txt"))

Now open the file.

Dim reader As New StreamReader(physicalPath)
' (Process the file here.)

reader.Close()

HTML and URL Encoding

The Server class also includes methods that change ordinary strings into a representation that can
safely be used as part of a URL or displayed in a web page. For example, imagine you want to display
this text on a web page:

To bold text use the <b> tag.

If you try to write this information to a page or place it inside a control, you would end up with
this instead:

To bold text use the tag.

Not only will the text <b> not appear, but the browser will interpret it as an instruction to make the
text that follows bold. To circumvent this automatic behavior, you need to convert potential problematic
values to their special HTML equivalents. For example, < becomes &lt; in your final HTML page, which
the browser displays as the < character. Table 3-4 lists some special characters that need to be encoded.

Table 3-4. Common HTML Entities

Result Description Encoded Entity
Nonbreaking space &nbsp;

< Less-than symbol &lt;

> Greater-than symbol &agt;

& Ampersand &amp;

" Quotation mark &quot;

Here’s an example that circumvents the problem using the Server.HtmlEncode() method:

Labell.Text = Server.HtmlEncode("To bold text use the <b> tag.")

You also have the freedom to use HtmlEncode for some input, but not for all of it if you want to
insert a combination of text that could be invalid and HTML tags. Here’s an example:
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Label1.Text = "To <b>bold</b> text use the "
Labell.Text &= Server.HtmlEncode("<b>") + " tag."

Note Some controls circumvent this problem by automatically encoding tags. (The Label web control is not one
of them. Instead, it gives you the freedom to insert HTML tags as you please.) For example, the basic set of HTML
server controls include both an InnerText tag and an InnerHtml tag. When you set the contents of a control using
InnerText, any illegal characters are automatically converted into their HTML equivalents. However, this won't help
if you want to set a tag that contains a mix of embedded HTML tags and encoded characters.

The HtmlEncode() method is particularly useful if you're retrieving values from a database and
you aren'’t sure if the text is valid HTML. You can use the HtmlDecode() method to revert the text to
its normal form if you need to perform additional operations or comparisons with it in your code.
Similarly, the UrlEncode() method changes text into a form that can be used in a URL, escaping
spaces and other special characters. This step is usually performed with information you want to
add to the query string.

It’s worth noting that the HtmlEncode() method won't convert spaces to nonbreaking spaces.
This means that if you have a series of space characters, the browser will display only a single space.
Although this doesn't invalidate your HTML, it may not be the effect you want. To change this behavior,
you can manually replace spaces with nonbreaking spaces using the String.Replace() method. Just
make sure you perform this step after you encode the string, not before, or the nonbreaking space
character sequence (&nbps;) will be replaced with character entities and treated as ordinary text.

Encode illegal characters.
Dim line = Server.HtmlEncode(line)

Replace spaces with nonbreaking spaces.
line = line.Replace(" ", "&nbsp;")

Similarly, the HtmlEncode() method won't convert line breaks into the <br> tag. This means
that hard returns will be ignored unless you specifically insert <br> tags.

Note The issue of properly encoding input is important for more than just ensuring properly displayed data. If
you try to display data that has embedded <script> tags, you could inadvertently end up executing a block of
JavaScript code on the client. Chapter 27 has more about this danger and the ASP.NET request validation feature
that prevents it.

User

The User object represents information about the user making the request of the web server, and it
allows you to test that user’s role membership.

The User object always implements System.Security.Principal. IPrincipal. The specific class
depends on the type of authentication you're using. For example, you can authenticate a user based
on Windows account information using IIS or through cookie-based authentication with a dedicated
login page. However, it’s important to realize that the User object provides useful information only if
your web application is performing some sort of authentication that restricts anonymous users.

Part 4 of this book deals with security in detail.

Trace

The Trace object is a general-purpose tracing tool (and an instance of the
System.Web.TraceContext class). It allows you to write information to a log that is scoped at the
page level. This log has detailed timing information so that not only can you use the Trace object for
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debugging but you can also use it for performance monitoring and timing. Additionally, the trace
log also shows a compilation of miscellaneous information, grouped into several sections. Table 3-5
describes all the information you'll see.

Table 3-5. Trace Log Information

Section

Description

Request Details

Trace Information

Control Tree

Session State and Application State

Cookies Collection

Headers Collection

Forms Collection
QueryString Collection

Server Variables

This section includes some basic information about the
request context, including the current session ID, the time
the web request was made, and the type of web request and
encoding.

This section shows the different stages of processing the
page went through before being sent to the client. Each
section has additional information about how long it took to
complete, as a measure from the start of the first stage (From
First) and as a measure from the start of the previous stage
(From Last). If you add your own trace messages (a technique
described shortly), they will also appear in this section.

The control tree shows you all the controls on the page,
indented to show their hierarchy, similar to the control tree
example earlier in this chapter. One useful feature of this
section is the Viewstate column, which tells you how many
bytes of space are required to persist the current information
in the control. This can help you gauge whether enabling
control state could affect page transmission times.

These sections display every item that is in the current
session or application state. Each item is listed with its name,
type, and value. If you're storing simple pieces of string
information, the value is straightforward. If you're storing an
object, .NET calls the object’s ToString() method to get an
appropriate string representation. For complex objects, the
result may just be the class name.

This section displays all the cookies that are sent with the
response, as well as the content and size of each cookie in
bytes. Even if you haven't explicitly created a cookie, you'll
see the ASPNET_Sessionld cookie, which contains the current
session ID. If you're using forms-based authentication, you'll
also see the security cookie.

This section lists all the HTTP headers associated with the
request.

This section lists the posted-back form information.

This section lists the variables and values submitted in the
query string.

This section lists all the server variables and their contents.

Tip Tracing complements Visual Studio debugging. In many cases, debugging is the best approach for solving
problems while you are coding a web application, while tracing gives you an easier option if you need to troubleshoot
problems that appear while the application is running on a web server. However, tracing provides a few services
that debugging doesn’t (at least not as easily), such as showing you the amount of information in view state and
the time taken to process the page on the server. Tracing also works regardless of whether you build your application
in debug mode (with the debug symbols) or release mode.
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You can enable tracing in two ways. You can set the Trace.IsEnabled property to True at any
point in your code, as follows:

Trace.IsEnabled = True

Usually, you'll do this in the Page.Load event handler. Another option is to use the Trace attribute
in the Page directive:

<%@ Page language="vb" CodeFile="PageFlow.aspx.vb" AutoEventWireup="true"
Inherits="PageFlow" Trace="true" %>

By default, trace messages are listed in the order they were generated. Alternatively, you can
specify that messages should be sorted by category, using the TraceMode attribute in the Page
directive, as follows:

<%@ Page language="vb" CodeFile="PageFlow.aspx.vb" AutoEventWireup="true"
Inherits="PageFlow" Trace="true" TraceMode="SortByCategory" %>

or the TraceMode property of the Trace object in your code:

Trace.TraceMode = TraceMode.SortByCategory

Figure 3-10 shows a partial listing of trace information with the PageFlow example demon-
strated earlier.

2l Page Flow - Microsoft Internet Explorer g@@
L

File Edit Vew Favorites Tools Help 2) = lﬂ &ll : 4~ Search Favorites £ v g % ;;% ’i i
Address @j http: flocalhost ;59402 /Chapter03/PageFlowTracing, asps v
~
Page It event handled
Page Load event handled.

Page PreEender event handled

Request Details

Session Id: wumlzguenb4ml30wa2tdifo Request Type:
Time of Request: 11/28/2005 11:22:38 AM Status CGode:
Request Encoding: Lnicode (UTF-2 Resp

Trace Information

Category Message From First(s) From Last(s)
aspx.page Begin Prelnit
asps.page End Prelnit 0.000122361920299926 0.000122
aspx.page Begin Init 0.00019974605711061 0.000077
aspx.page End Init 0.00110069855246966 0.000901
aspy.page Begin InitCamplete 0.00125071761913875 0.000150
aspx.page End InitComplete 0.00133313032801655 0.000082
aspx.page Begin PreLoad 0.001383416043687F75 0.000050
asps.page End PreLoad 0.00143286367401443 0.000049
aspx.page Begin Load 0.00148175256911144 0.000049
aspx.page End Load 0.00154069860834268 0.000052
aspx.page Begin LoadComplete 0.00159070495389904 0.000050
aspr.page End LoadCormplete 0.00163931449366121 0.000049
aspx.page Begin PreRender 0.00168708592851885 0.000048
aspx.page End PreRender 0.00177396847923409 0.000087
aspr.page Begin PreRenderComplete 0.00182229864410142 0.000048
aspx.page End PreRenderComplete 0.00186951134850938 0.000047
aspx.page Begin SaveState 0.00404129575127565 0.002172
aspr.page End SaveState 0.00455812121372968 0.000517
aspx.page Begin SaveStateComplete 0.00466400059225404 0.000108
aspx.page End SaveStateComplete 0.00471931488499237 0.000055
aspr.page Beqin Render 0.00476764504985969 0.000048 ™
E
& Dore & Local intranst

Figure 3-10. Basic trace information
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You can also write your own information to the trace log (the portion of the trace log that
appears in the Trace Information section) using the Trace.Write() or Trace.Warn() method. These
methods are equivalent. The only difference is that Warn() displays the message in red lettering,
which makes it easier to distinguish from other messages in the list.

Here’s a code snippet that writes a trace message when the user clicks a button:

Protected Sub Buttoni Click(ByVal sender As Object, ByVal e As System.EventArgs)
You can supply just a message, or include a category label,
as shown here.
Trace.Write("Button1 Click", "About to update the label.")
1blInfo.Text &= "Buttoni.Click event handled.<br />"
Trace.Write("Button1 Click", "Label updated.")
End Sub

When you write trace messages, they are automatically sent to all trace listeners. However, if
you've disabled tracing for the page, the messages are simply ignored. Tracing messages are automati-
cally HTML-encoded. This means tags such as <br /> and <b> are displayed as text, not interpreted as

HTML.

Figure 3-11 shows the new entries that have been traced.

Trace Information

aspx.page Begin Prelnit

asps.page End Prelnit 0.000139123827190327 0.000139
asps.page Begin Init 0.000217066694230691 0.000078
asps.page End Init 0.000311212737931776 0.000094
aspx.page Begin InitComplete 0.000360380995143619 0.000049
aspx.page End InitComplete 0.000416812751341302 0.000056
asps#.page Begin LoadState 0.000465142916208624 0.000048
asps.page End LoadState 0.000799263593557282 0.000334
asps#.page Begin ProcessPostData 0.000898438209325487 0.000099
asps.page End ProcessPostData 0.00102722552726673 0.000129
asps.page Begin PreLoad 0.00110349220361806 0.000076
asps.page End PreLoad 0.00115321919405958 0.000050
asps#.page Begin Load 0.00119987316823786 0.000047
asps.page End Load 0.00125881920746911 0.000059
aspx.page Begin ProcessPostData Second Try 0.00130575254676223 0.000047
asps.page End ProcessPostData Second Try 0.00135100969536631 0.000045
aspx.page Begin Raise ChangedEvents 0.00139738430442975 0.000046
aspx.page End Raise ChangedEvents 0.00144571446929708 0.000048
aspx.page Begin Raise PostBackEvent 0.0014926478085902 0.000047
Buttonl_Click About to update the label. 0.00488274347717377 0.003390
Buttonl_Click Label updated. 0.00511154350622775 0.000229
aspx.page End Raise PostBackEvent 0.00521826098009663 0.000107
aspx.page Begin LoadComplete 0.005268826065588268 0.000051
aspx.page End LoadComplete 0.00531715623075 0.000048
asps#.page Begin PreRender 